SuperNova
Magnifier
Version 15.0

Dolphin Computer Access
Publication Date: 19 August 2015

Copyright ©1998-2015 Dolphin Computer Access Ltd.
Technology House
Blackpole Estate West
Worcester WR3 8TJ
United Kingdom
Tel: +44 (0) 1905 754577
Fax: +44 (0) 1905 754559
All Rights Reserved World-wide.

Contents
1. How to find help

9

1.1 Use the quick reference booklet ............................................. 9
1.2 Get help using an application ................................................. 9
1.2.1 Move within help topics .................................................. 10
1.2.2 Move between Help topics ............................................. 10
1.2.3 Switch between Help and your application ..................... 10
1.2.4 Add personal notes ........................................................ 11
1.3 Get Help from the SuperNova Control Panel ....................... 11
1.3.1 Use the Help Button ....................................................... 11
1.3.2 Explore the Help menu................................................... 12
1.4 Get support for SuperNova ................................................... 12
1.4.1 Find help on the Dolphin website ................................... 12
1.4.2 Contact your Dolphin Dealer for support ........................ 13
1.4.3 Contact Dolphin UK Product Support ............................. 13
1.4.4 Contact Dolphin USA Product Support........................... 14
1.4.5 Find your product version number and your product serial
number ................................................................................... 14
1.4.6 Get further product training ............................................ 14

2. Install and Set Up

17

2.1 Start SuperNova ..................................................................... 17
2.2 Run SuperNova for the first time .......................................... 17
2.3 Quit SuperNova ...................................................................... 17
3. SuperNova Control Panel

19

3.1 Introducing the SuperNova Control Panel ........................... 19
3.2 Keyboard commands to get around the SuperNova Control
Panel ............................................................................................. 20
3.3 Settings in the SuperNova Control Panel ............................. 21
3.4 Change the appearance of the SuperNova Control Panel ... 22
3.5 Close the SuperNova control panel ...................................... 22
4. Magnifier

23

4.1 Turn magnification on or off.................................................. 23
4.2 Change magnification size .................................................... 23
4.3 Change Magnifier view .......................................................... 24
4.4 Change size and position of the magnified window ............ 25
4.5 View other parts of the screen .............................................. 26
4.6 Get an overview of the magnified window position ............. 29
4.7 Create static magnified windows to display information .... 29
4.7.1 Create a Hooked Area using the keyboard ..................... 30
4.7.2 Modify a Hooked Area using the keyboard ..................... 30
4.7.3 Delete a Hooked Area using the keyboard ..................... 31
4.7.4 Create a Hooked Area using the mouse......................... 31
4.7.5 Show or hide Hooked Areas ........................................... 32

5. Screen colours, highlights and mouse pointers

35

5.1 Change the colours on the screen ........................................ 35
5.2 Highlight the focus................................................................. 36
5.3 Change the size and colour of the mouse pointer ............... 36
6. Line View

39

6.1 Start Line View ....................................................................... 39
6.2 Scroll text in Line View .......................................................... 40
6.3 Change the colour, font and items displayed in Line View . 40
7. Doc Reader

43

7.1 Launch Doc Reader ............................................................... 43
7.2 Control reading ...................................................................... 43
7.3 Exit Doc Reader ..................................................................... 45
8. Bookshelf

47

8.1 Bookshelf Books .................................................................... 47
8.1.1 Open a file in the SuperNova Reader:............................ 47
8.1.2 Open a book from an online library ................................ 48
8.1.3 Open the last book you were reading ............................. 49
8.1.4 Open, copy or delete an existing book ........................... 50
8.2 Bookshelf News, Radio Stations and Podcasts................... 50
8.2.1 Read a news article ....................................................... 51
8.2.2 Listen to a radio station .................................................. 51
8.2.3 Listen to a podcast ......................................................... 52
8.2.4 Adjust the favourite news, radio station and podcast listings
............................................................................................... 52

8.3 SuperNova Reader keyboard commands ............................. 53
9. Settings Files

55

9.1 Create Application Settings................................................... 55
9.2 Create Situation Settings ....................................................... 55
9.3 Save setting changes ............................................................. 56
9.4 Change Map file...................................................................... 57
10. Touchscreen

59

10.1 Touchscreen terminology.................................................... 59
10.2 Touchscreen gestures ......................................................... 60
10.3 SuperNova Touch Bar .......................................................... 61
10.4 Typing on a touchscreen ..................................................... 61
10.5 Adjust touch sensitivity ....................................................... 61
11. Hot key conflicts

63

11.1 Turn off SuperNova hot keys .............................................. 63
11.2 Tell SuperNova to ignore the next key press ..................... 63
11.3 Reassign a SuperNova hot key ........................................... 64
12. Hot Keys

65

12.1 Actions .................................................................................. 65
12.2 Magnifier ............................................................................... 66
12.3 Magnifier Window Adjustment ............................................ 69
12.4 Line View .............................................................................. 72
12.5 Item Finder ............................................................................ 73
12.6 Quick Navigation Keys for Microsoft Word ........................ 74
12.6.1 Quick Navigation Keys ................................................. 74

13. Reference

77

13.1 New Situation Settings dialog box ...................................... 77
13.2 New Application Settings dialog box.................................. 77
13.3 New Map dialog box ............................................................. 78
13.4 New Script menu item .......................................................... 78
13.5 Edit Situation Settings dialog box ...................................... 78
13.6 Edit Application Settings dialog box .................................. 79
13.7 Edit Map dialog box ............................................................. 80
13.8 Edit Script menu item .......................................................... 80
13.9 Visual Configure Custom Colour Scheme dialog box ....... 80
13.10 Visual Highlighting Options dialog box ............................ 81
13.11 Visual Mouse Pointers dialog box .................................... 83
13.12 Visual Doc Reader Settings dialog box ............................ 84
13.13 Visual Multiple Monitors dialog box ................................. 86
13.14 Visual Advanced Options dialog box ............................... 88
13.15 General Startup Preferences dialog box .......................... 92
13.16 General Update Settings dialog box ................................. 93
13.17 General Control Panel dialog box ..................................... 93
13.18 General Keyboard dialog box............................................ 94
13.19 General Hot Keys dialog box............................................. 95
13.20 General Touchscreen Settings dialog box ....................... 95
13.21 General Advanced Options dialog box ............................. 97
13.22 Item Finder dialog box ....................................................... 97
14. Index

99

9

CHAPTER 1

How to find help

1.1 Use the quick reference booklet
A quick reference booklet is included in the box containing your SuperNova
software. This book contains information on getting started with SuperNova,
covering the popular hot keys you use with this software.

1.2 Get help using an application
SuperNova includes help on how to use many popular applications.
Help includes:
 How to configure the application for best performance.
 How to complete many common tasks using only the keyboard.
 A list of popular hot keys.
While SuperNova is running, you can open the SuperNova Help from within
your application. When you open the SuperNova Help menu, the first item
will link to specific information about using SuperNova with the current
application.
To do this:
1. Press CAPS LOCK + F1.
A context menu opens.
2. DOWN ARROW to select the name of your application. For example,
Microsoft Word 2007 and then press ENTER.
SuperNova opens an HTML Help window, which contains the
help content.
When you wish to return to your application, you can press ALT + F4 to
close the Help window.
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1.2.1 Move within help topics
You can use Arrow Keys to move around within topics. In addition, you can
use the following web page navigation commands to move around within
help topics. Visit the Internet Explorer section of the SuperNova manual For
a complete list of hot keys for moving around web pages.
 Move to the next link, TAB.
 Move to the previous link, SHIFT + TAB.
 Move to the bottom of the current document, CONTROL + END.
 Move to the top of the current document, CONTROL + HOME.
When you wish to return to your application, you can press ALT + F4 to
close the Help window.
1.2.2 Move between Help topics
You can use the links at the top of each topic to go to the next or previous
topic.
To do this:
1. Press CONTROL + HOME to move to the top of the document.
2. Press TAB to move by link until you hear "Previous Topic Link" or "Next
Topic Link". You can press SHIFT + TAB to move back to any links you
may have skipped.
3. Follow the link you have chosen by pressing ENTER.
You can use the "Home" link to move to a page containing links to all topics
relating to the current application.
When you wish to return to your application, you can press ALT + F4 to
close the Help window.
1.2.3 Switch between Help and your application
You can remember your place in the SuperNova Help by keeping the
SuperNova Help Browser window open. You may find it useful to switch
between the SuperNova Help Browser window and your application
window several times while carrying out help instructions.
To do this:
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1. From the SuperNova Help window, press ALT + TAB to switch back to
your application.
2. Carry out any actions in your application.
3. Press ALT + TAB to return to your position in the Help window.
When you have finished using SuperNova help, you can press ALT + F4 to
close the Help window.
1.2.4 Add personal notes
You can add personal notes in the SuperNova Help. You might do this to
keep a note of certain hot keys or steps you need to follow to complete a
task in an application.
To do this:
1. Run your application.
2. Press CAPS LOCK + F1.
The SuperNova Help menu opens.
3. DOWN ARROW to “My Notes” and press ENTER.
A blank document in NotePad or equivalent text editor opens.
4. Add your text to the file.
5. Save and close the file.
You can review and add to your notes by selecting the “My Notes” item in
the SuperNova Help menu. The text files you create are saved in your
\Settings folder.

1.3 Get Help from the SuperNova Control Panel
Your SuperNova Control Panel provides two ways of getting help.
 The Help button.
 The Help menu.
1.3.1 Use the Help Button
The Help button in the SuperNova Control Panel is context sensitive.
When you press this button, SuperNova opens the relevant section of the
manual containing an explanation of the SuperNova settings in view.
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If the SuperNova Control Panel is not open, you can open it using LEFT
CONTROL + SPACEBAR.
You can press the Help button in any of these ways:
 Left clicking the "Help" button on the Control Panel with the mouse.
 TAB to the "Help" button and press SPACEBAR.
 Press F1.
1.3.2 Explore the Help menu
The Help menu provides access to the complete SuperNova manual. The
complete manual is particularly useful when you need to lookup a particular
piece of information.
1. If the SuperNova control panel is not open, you can open it using LEFT
CONTROL + SPACEBAR.
2. When in the SuperNova control panel, press ALT + H to open the
"Help" menu. The first item in the menu is "SuperNova Manual".
3. Press ENTER to open the SuperNova manual.
Use the following keys to navigate the SuperNova manual:
 Choose a section, UP and DOWN ARROW Keys.
 Expand and collapse individual sections, RIGHT and LEFT ARROW
Keys.
 Open a topic, ENTER.
 Move between the contents and the open topic, F6.

1.4 Get support for SuperNova
1.4.1 Find help on the Dolphin website
The Dolphin website offers a comprehensive range of support materials to
help you get the most out of your Dolphin product. A variety of
documentation is available, from handy tips and tutorials, to more technical
knowledge base articles offering solutions to less common problems.
To do this:
1. Open a web browser and visit http://www.YourDolphin.com.
2. Choose the "Support" link from the main navigation menu.
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3. Choose one of the options available to you:
 Manuals and user guides. Dolphin's training Manuals and Quick Start
Guides will help you get to grips with our products quickly and easily.
 Tips & Tutorials. Handy step by step online tutorials covering the main
product features.
 Knowledge Base. The Knowledge Base is a searchable database
containing a wealth of information and solutions to issues you might
have with your Dolphin product.
1.4.2 Contact your Dolphin Dealer for support
If you purchased your Dolphin software from a registered Dolphin dealer,
you can contact the dealer directly to receive the most appropriate localised
support. If you do not know the contact details for your dealer, you can
obtain these from the Dolphin website.
To do this:
1. Open a web browser and visit http://www.YourDolphin.com.
2. Choose the "Dealers" link from the main navigation menu. This will
open the "Dealer Locator" page.
3. Select your country from the list then choose the "Submit" button. This
will open a page displaying a list of Dolphin Dealers for that country.
4. Review the results to locate the contact details for the dealer from which
you purchased your Dolphin product.
1.4.3 Contact Dolphin UK Product Support
At Dolphin we pride ourselves in the quality and level of Product Support
we provide to all our customers. Our goal is to continue to provide Product
Support that is second to none. You can contact our Product Support team
in a number of ways.
To do this:
 By telephone: +44 (0)1905 754765.
 By telephone (UK Local Rate): 0345 130 5454.
 By Fax: +44 (0) 1905 754 559.
 By Email: support@yourdolphin.com.
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1.4.4 Contact Dolphin USA Product Support
At Dolphin we pride ourselves in the quality and level of Product Support
we provide to all our customers. Our goal is to continue to provide Product
Support that is second to none. You can contact our Product Support team
in a number of ways.
To do this:
 By telephone (Toll free): 888 519 4694
 By telephone (International): +1 609 803 2173.
 By Email: support@dolphinusa.com.
1.4.5 Find your product version number and your product serial
number
In the SuperNova "About" dialog box you can find information about:
 Your SuperNova version number.
 Your personal SuperNova serial number.
 A copy of the SuperNova software license agreement.
To open this dialog box:
1. Press LEFT CONTROL + SPACEBAR. This will open the SuperNova
control panel.
2. Press ALT + H. This will open the "Help" menu.
3. DOWN ARROW to "About" and press ENTER. This will open the
"About" dialog box.
1.4.6 Get further product training
Dolphin has a network of approved trainers who are available to offer you
high quality training either within your home or in your place of work. Our
trainers can personalise the training to your individual requirements
allowing you to maximise your independence, whilst taking into account
your level of technical knowledge. You can contact Dolphin to find a
Dolphin approved trainer in your area.
To do this:
 By telephone: +44 (0)1905 754577.
 By Email: info@dolphinuk.co.uk.
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CHAPTER 2

Install and Set Up

2.1 Start SuperNova
SuperNova will start automatically after you log onto your computer unless
you have stated otherwise during the installation process.
You can manually start SuperNova after log on by using the SuperNova
shortcut key.
Press CONTROL + SHIFT + S.
If you have installed a new version alongside your existing version then the
new version will be automatically given the following shortcut key:
Press CONTROL + SHIFT + D.
You can also launch SuperNova by selecting the SuperNova shortcut in the
Windows Start menu. This is in the Programs, Dolphin sub-menu.

2.2 Run SuperNova for the first time
You will be guided through the setup process the first time you run
SuperNova after installation.
The setup process will guide you through:
 Unlocking and activating.
 Changes to the SuperNova defaults settings.
 Customer feedback options.
 Checking for the latest SuperNova product updates.
You can choose to go through all the steps, skip some or cancel the setup
process. You can run each step in the setup process at a later date from
the "Help" menu in the SuperNova control panel.

2.3 Quit SuperNova
To quit SuperNova:
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1. Press LEFT CONTROL + SPACEBAR. This will open the SuperNova
control panel.
2. Press ALT + F. This will open the "File" menu.
3. DOWN ARROW to "Quit SuperNova" and press ENTER. A message
window will appear asking you to confirm you want to quit.
4. TAB to the "Yes" button and press SPACEBAR.
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CHAPTER 3

SuperNova Control Panel

3.1 Introducing the SuperNova Control Panel

The SuperNova Control Panel is the place that contains all of the settings
for SuperNova.
You can find the SuperNova settings in the Control Panel's menu bar and
the button bar.
The menu bar, which is the horizontal bar positioned below the title bar
containing options to drop down menus, provides access to all the settings
available in SuperNova. The button bar, which is positioned below the
menu bar and contains large easy to access buttons, provides access to
SuperNova's most commonly used settings.
The final part of the SuperNova Control Panel is the status bar. The status
bar, which is the horizontal bar at the bottom of the SuperNova Control
Panel, provides information about the Settings files you are using.
You can open the SuperNova Control Panel in several ways.
which suits you best.

Use the one

To open the SuperNova main Control Panel:
Press LEFT CONTROL + SPACEBAR.
This opens the full Control Panel as a dialog box.
Alternatively, using the mouse, to open the SuperNova Control
Panel:
Click the SuperNova icon in the Windows Notification Area.
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To open the SuperNova Control Panel as a simple menu:
Press CAPS LOCK + SPACEBAR or RIGHT CLICK the SuperNova
icon in the Windows Notification Area.

3.2 Keyboard commands to get around the SuperNova
Control Panel
The following tables provide a list of keyboard commands to help you get
around the SuperNova Control Panel. Note that these keyboard commands
are also standard Windows commands that you can use throughout
Windows.
Keyboard Commands for the menu bar.
Function
Hot key
Move focus to the menu bar
ALT
Move focus across the menu bar LEFT ARROW or
RIGHT ARROW
Open the menu item that has
DOWN ARROW or
focus
ENTER
Move to and open a menu bar
ALT + Underlined letter
item
Move through an open menu
DOWN ARROW or UP
ARROW
Open a submenu
RIGHT ARROW or
ENTER
Close a submenu
LEFT ARROW or
ESCAPE
Select a menu item
ENTER

Keyboard Commands for dialog boxes
Function
Hot key
Move to the next control
TAB
Move to the previous control
SHIFT + TAB

SuperNova Control Panel
Press a button, toggle a check
box or select an option
Move directly to a control
Open the next tab in a multi tab
dialog box
Open the previous tab in a multi
tab dialog box
Cancel
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SPACEBAR
ALT + Underlined letter
CONTROL + TAB
CONTROL + SHIFT +
TAB
ESCAPE

3.3 Settings in the SuperNova Control Panel
All the SuperNova Options can be accessed through the menus in the
SuperNova Control Panel. The following list summarises the purpose of
the menus.
 File menu:
The "File" menu contains options for managing SuperNova
Settings files. This includes creating, editting, importing and
exporting settings files. The "File" menu also contains the
command to quit SuperNova.
 Visual menu.
The "Visual" menu contains the options to control magnification,
screen colours, highlighting and other visual effects. You can also
access many of these settings through the SuperNova button bar.
 Bookshelf menu.
The "Bookshelf" menu contains options for scanning, searching
for books, reading online news articles, listening to radio stations
and playing podcasts.
 General menu.
The "General" menu contains options that control SuperNova's
behaviour including startup preferences, update settings, Control
Panel appearance and SuperNova keyboard and hot key
assignments.
 Help menu.
The "Help" menu provides shortcuts to useful resources including
the SuperNova Manual, online resources and the "About" option.
The "About" option provides you with your customer ID number
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plus the edition, version and build of SuperNova you are currently
running. Ensure you have this information at hand if you require
technical assistance.

3.4 Change the appearance of the SuperNova Control Panel
You can make many changes to the SuperNova Control Panel. For
example, you can hide the button bar, hide the status bar, stop the Control
Panel appearing when you run SuperNova and remove it from the
Windows Taskbar.
For information about changing the SuperNova Control Panel, see the
"General Control Panel dialog box".

3.5 Close the SuperNova control panel
You can close the SuperNova Control Panel in several ways.
To do this:
Press ESCAPE.
Or,
Click the minimise icon in the SuperNova Control Panel title bar.
When you do this, the SuperNova Control Panel disappears and the focus
goes back to the application you were previously running. SuperNova
continues to run.
NOTE: If you press ALT + F4 or click the close button in the
SuperNova Control Panel title bar, then SuperNova will assume you
want to quit the program. Before quitting, a message window
appears asking you to confirm the action.
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CHAPTER 4

Magnifier

4.1 Turn magnification on or off

You can turn on or off magnification using the "Visual" options in the
SuperNova control panel or by using hot keys. If you are using a
touchscreen device, you can also turn magnification on or off by doing a 3
finger double tap.
Magnifier Hot Keys
Function

Turn off or on magnification

Desktop Default
NumPad Set
LEFT
CONTROL +
NUMPAD
ENTER

Laptop Universal Set
ALT + 0

4.2 Change magnification size

You can change the power of magnification from 1.2x to 64x. You can
change the magnification size using the "Visual" options in the SuperNova
control panel or by using hot keys. If you are using a touchscreen device,
you can also change magnification by doing a 2 finger pinch or 2 finger
stretch.
Magnifier Hot Keys
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Function

Increase magnification

Reduce magnification

Desktop Hot
Keys
LEFT
CONTROL +
NUMPAD
PLUS
or
CAPS LOCK +
MOUSE
WHEEL UP
LEFT
CONTROL +
NUMPAD
MINUS
or
CAPS LOCK +
MOUSE
WHEEL
DOWN

Laptop Universal Set
ALT +
EQUALS
or
CAPS LOCK +
MOUSE
WHEEL UP

ALT + DASH
or
CAPS LOCK +
MOUSE
WHEEL
DOWN

4.3 Change Magnifier view

You can choose different ways to view the screen using the SuperNova
Magnifier. This includes the following viewing options:
 Full Screen.
This view fills the screen with a magnified portion of the "real"
Windows screen.
 Fixed Window.
This view shows the magnified region of the screen in a small static
window. You can change the size and position of the window.
 Magnifying Glass
This view behaves like holding a magnifying glass to the screen. You
view the magnified region of the screen in a small moving window.
You can change the size and position of the window.
 Resizing Glass
This view behaves similar to the Magnifying Glass except that the
magnified window will automatically resize itself to the size of the

Magnifier
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current focus. This view is useful if you use the keyboard to navigate
Windows and feel more comfortable seeing the unmagnified screen in
the background.
 Split Screen.
This view splits the screen into two regions: a magnified window and
an unmagnified window. You can choose where the magnified window
appears and the size of the magnified window. The border between
the magnified and unmagnified screen is shown as a black line. This
mode is popular when also using an integrated CCTV package.
You can change your viewing style by using the "Visual" options in the
SuperNova control panel or by using hot keys.
Magnifier Hot Keys
Function

Change Magnifier view

Change orientation when in
Split Screen view

Desktop Default
NumPad Set
LEFT
CONTROL +
NUMPAD 7
LEFT
CONTROL +
NUMPAD 1

Laptop Universal Set
ALT + SHIFT +
M
No Assignment

Note that you can change the size and colour of the border around the
Fixed Window, Magnifying Glass, Resizing Glass and Split Screen views.
You make this change in the "Visual Advanced Options" dialog box.

4.4 Change size and position of the magnified window
You can change the size and position of the Fixed Window, Magnifying
Glass and Split Screen window. You make the change using a
magnification modification mode.
To adjust the size and position of the Fixed Window view:
1. Choose "Fixed Window" as the Magnifier View setting.
2. If using the Desktop Hot Key set, press LEFT CONTROL + NUMPAD 4
to enter magnification modification mode. If using the Laptop Hot Key
set, press RIGHT CONTROL + F3 to enter magnification modification
mode.
In magnification modification mode, a flashing border indicates the
object you are editing.
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3. Use the Arrow Keys to position the window on the screen. You can also
do this by holding down the Z key and move the mouse.
4. Press LEFT CONTROL + Arrow Keys to adjust the size of the window.
You can also do this by holding down the X key and move the mouse.
5. Press ESCAPE to exit magnification modification mode.
To adjust the size of the Magnifying Glass view:
1. Choose "Magnifying Glass" as the Magnifier View setting.
2. If using the Desktop Hot Key set, press LEFT CONTROL + NUMPAD 4
to enter magnification modification mode. If using the Laptop Hot Key
set, press RIGHT CONTROL + F3 to enter magnification modification
mode.
In magnification modification mode, a flashing border indicates the
object you are editing.
3. Press LEFT CONTROL + Arrow Keys to adjust the size of the window.
You can also do this by holding down the X key and move the mouse.
4. Press ESCAPE to exit magnification modification mode.
To adjust the size of the Split Screen view:
1. Choose the Split Screen orientation that you are going to use as the
Magnifier View setting.
2. If using the Desktop Hot Key set, press LEFT CONTROL + NUMPAD 4
to enter magnification modification mode. If using the Laptop Hot Key
set, press RIGHT CONTROL + F3 to enter magnification modification
mode.
In magnification modification mode, a flashing border indicates the
object you are editing.
3. Press LEFT CONTROL + Arrow Keys to adjust the size of the window.
You can also do this by holding down the Z key and move the mouse.
4. Press ESCAPE to exit magnification modification mode.

4.5 View other parts of the screen
Only one part of the screen is visible when using magnification. To view the
other parts of the screen, you can move the mouse pointer around the
screen or use SuperNova hot keys.
Moving around the screen using SuperNova hot keys is described as either
panning, moving, move to or jumping.

Magnifier
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 Panning.
Panning moves the magnified area across the screen at a constant
speed in the direction you specify. The speed of movement can be
increased or slowed depending on the keys pressed.
To pan across the screen press RIGHT CONTROL plus an Arrow
Key. Hold down RIGHT CONTROL to keep panning. Press the same
Arrow Key repeatedly (keeping RIGHT CONTROL pressed) to speed
up the panning. Press the opposite Arrow Key to slow down.
Use the other Arrow Keys to change direction. Release RIGHT
CONTROL to stop panning.
 Moving (accelerated panning).
Moving works in a similar way to panning, except that the speed of
the panning will automatically accelerate up to a certain top speed
whilst you have the keys held down.
To move the magnified area press and hold down RIGHT CONTROL
+ RIGHT SHIFT together with an Arrow Key. When you let go,
moving will stop.
 Move To.
You can also move the magnified area directly to various parts of the
screen. The following table lists the hot keys that will allow you to
move the magnified area to a screen position.
Magnifier Hot Keys
Function

Top left

Top

Top right

Left

Desktop Default
NumPad Set
RIGHT
CONTROL +
NUMPAD 7
RIGHT
CONTROL +
NUMPAD 8
RIGHT
CONTROL +
NUMPAD 9
RIGHT
CONTROL +
NUMPAD 4

Laptop Universal Set
No
Assignment
No
Assignment
No
Assignment
No
Assignment
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Centre

Right

Bottom left

Bottom

Bottom right

RIGHT
CONTROL +
NUMPAD 5
RIGHT
CONTROL +
NUMPAD 6
RIGHT
CONTROL +
NUMPAD 1
RIGHT
CONTROL +
NUMPAD 2
RIGHT
CONTROL +
NUMPAD 3

No
Assignment
No
Assignment
No
Assignment
No
Assignment
No
Assignment

 Jump Movement.
Movement around the screen is also possible in steps. This is
different to panning as the magnified window does not scroll smoothly
but rather moves in steps.
Magnifier Hot Keys
Function

Up

Down

Left

Desktop Default
NumPad Set
LEFT
CONTROL +
CAPS LOCK +
NUMPAD 8
LEFT
CONTROL +
CAPS LOCK +
NUMPAD 2
LEFT
CONTROL +
CAPS LOCK +
NUMPAD 4

Laptop Universal Set
RIGHT
CONTROL +
RIGHT SHIFT
+ UP ARROW
RIGHT
CONTROL +
RIGHT SHIFT
+ DOWN
ARROW
RIGHT
CONTROL +
RIGHT SHIFT
+ LEFT
ARROW

Magnifier
Right

LEFT
CONTROL +
CAPS LOCK +
NUMPAD 6
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RIGHT
CONTROL +
RIGHT SHIFT
+ RIGHT
ARROW

Save and Restore Screen Position
Also available is the opportunity to save a screen position. This will then
allow you to return to the same position with the press of a hot key.
To save a screen position:
1. Move the magnified window to the required position.
2. Press RIGHT CONTROL + NUMPAD 0 to save the position.
To move the magnified window back to the saved position:
Press RIGHT CONTROL + NUMPAD PERIOD to return to the saved
screen position.

4.6 Get an overview of the magnified window position
You can see the position the magnified window is on the screen by using
Magnifier Overview. You switch in and out of Magnifier Overview using a
SuperNova hot key.
To enter and exit Magnifier Overview:
Press LEFT CONTROL+ BACKSLASH.

4.7 Create static magnified windows to display information
You can create static magnified windows to keep a particular area of the
screen permanently displayed. This lets you see important information that
may frequently change as you use your application.
SuperNova calls these windows "Hooked Areas". Hooked Areas can have
their own magnification size and will be visible even if you turn off the
SuperNova Magnifier.
Examples:
 You can hook the system tray clock to make it easy to see the time.
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 You can hook the place on a word processor's status bar that reports
the current page number to make it easy to see what page you are
currently working on.
 You can hook the Formula Bar in a spreadsheet to make it easy to
see if the current cell contains a formula or text.
You can create a Hooked Area by using the mouse pointer or by using the
keyboard.
4.7.1 Create a Hooked Area using the keyboard
To create and change the position and size of a Hooked Area window
using hot keys requires the use of magnification modification mode.
To create and adjust the size and position of a Hooked Area:
1. If using the Desktop Hot Key set, press LEFT CONTROL + NUMPAD 5
to create a new Hooked Area and automatically enter magnification
modification mode. If using the Laptop Hot Key set, press LEFT
CONTROL + LEFT SHIFT + ALT + H to create a new Hooked Area and
automatically enter Magnification Modification Mode
In magnification modification mode, a flashing border indicates the
object you are editing.
2. Use the Magnifier hot keys to change the size of the content inside the
Hooked Area.
3. Use the Arrow Keys to position the window on the screen. You can also
do this by holding down the Z key and move the mouse.
4. Press LEFT SHIFT + Arrow Keys to alter the content inside the Hooked
Area. You can also do this by holding down the C key and move the
mouse.
5. Press LEFT CONTROL + Arrow Keys to adjust the size of the window.
You can also do this by holding down the X key and move the mouse.
6. Press ESCAPE to exit magnification modification mode.
During the creation process you will probably find it is only through
repeated adjustment of size, position and content within the Hooked Area
do you get the desired result.
4.7.2 Modify a Hooked Area using the keyboard
To modify an existing hooked area:

Magnifier
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1. If using the Desktop Hot Key set, press LEFT CONTROL + NUMPAD 6.
If using the Laptop Hot Key set, press LEFT CONTROL + F6. This will
enter magnification modification mode with the currently selected
Hooked Area identified by a flashing border.
2. If you have multiple Hooked Areas then you can cycle between the
Hooked Areas by pressing LEFT CONTROL + NUMPAD 6 if using the
Desktop Hot Key set. Press LEFT CONTROL + F6 if using the Laptop
Hot Key set.
3. Use the available Magnifier hot keys and Magnification Modification
Mode hot keys to adjust the size, location or content of the Hooked
Area.
4. Press ESCAPE to exit Magnification Modification Mode.

4.7.3 Delete a Hooked Area using the keyboard
To delete an existing hooked area:
1. If using the Desktop Hot Key set, press LEFT CONTROL + NUMPAD 6.
If using the Laptop Hot Key set, press LEFT CONTROL + F6. This will
enter Magnification Modification Mode with the currently selected
Hooked Area identified by a flashing border.
2. If you have multiple Hooked Areas then you can cycle between the
areas. To do this press LEFT CONTROL + NUMPAD 6 if using the
Desktop Hot Key set. Press LEFT CONTROL + F6 if using the Laptop
Hot Key set.
3. Press DELETE to remove the Hooked Area.
When the Hooked Area is deleted the focus will move to the next Hooked
Area. If no Hooked Areas remain then Magnification Modification Mode will
be automatically exited. If additional Hooked Areas remain that you do not
want to modify then press ESCAPE.
4.7.4 Create a Hooked Area using the mouse

You can create Hooked Areas through the "Create Hooked Areas" dialog
box. To open this dialog box select the "Hooks" button in the Visual
property sheet and then select the "New" button.
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In the "Create Hooked Areas" dialog box you will need to:
1. Provide a unique description for the hooked area.
2. Select or unselect the "Track focus" check box.
Track focus determines whether the content of the hooked area is
fixed or shows the current focus. Select this check box and the
contents of the hooked area will track the focus. If this check box is
selected then the "Choose screen area to hook" button will be
disabled as an area of the screen is not being defined.
3. Select the "Choose screen area to hook" button to define the screen
area to display.
4. Use LEFT MOUSE BUTTON with mouse movement to create a new
area. Press ENTER or the RIGHT MOUSE BUTTON to accept,
ESCAPE to cancel.
5. Select or unselect the "Smoothing" check box.
6. Select the "Move the hook window" button to position the hooked area
and to set the magnification size.
The magnification size can be set using the normal hot keys. Use
mouse movement or the CURSOR KEYS to move the hook. Press
ENTER or the LEFT MOUSE BUTTON to accept, ESCAPE to cancel.
7. Select the "OK" button to confirm and save the new Hooked Area.
You can view a list of your created Hooked Areas in the "Hooked Areas"
tab, in the "Visual Advanced Options" dialog box. You can also sort, modify
and delete existing Hooked Areas in the "Hooked Areas" tab.
4.7.5 Show or hide Hooked Areas
You can show or hide Hooked Areas using a SuperNova hot key. This can
be useful if you do not want the Hooked Areas to be visible all the time but
rather as and when information from other areas of the screen is required.
Magnifier Hot Keys
Function

Turn off or on Hooked Areas

Desktop Default
NumPad Set
LEFT
CONTROL +
NUMPAD 3

Laptop Universal Set
LEFT
CONTROL +
F5

Magnifier
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CHAPTER 5

Screen colours, highlights and mouse pointers

5.1 Change the colours on the screen

You can change the colours on the screen by choosing a SuperNova
Colour Scheme. This can often help reduce eye strain if viewing a screen
with difficult colour combinations.
To change the screen colours:
1. Press LEFT CONTROL + SPACEBAR. This will open the SuperNova
control panel.
2. Press ALT + V. This will open the "Visual" menu.
3. DOWN ARROW to "Colour Scheme" and press ENTER. This will
change the screen colours to the currently selected SuperNova Colour
Scheme.
4. If the default Colour Scheme is not suitable, go back to the "Visual"
menu, open the "Colour Scheme" sub-menu and choose a different
scheme from the list.
You can switch between your selected Colour Scheme and the normal
screen colours by deselecting the "Colour Scheme" item in the "Visual"
menu, in the SuperNova control panel.
You can also do this using a SuperNova hot key.
Magnifier Hot Keys
Function

Turn on or off your Colour
Scheme

Desktop Default
NumPad Set
LEFT
CONTROL +
NUMPAD 0

Laptop Universal Set
ALT + SHIFT +
C
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5.2 Highlight the focus

You can make different types of focus easier to see by adding a highlight
indicator. You can choose the style, colour and behaviour of the highlight.
To select a scheme:
1. Press LEFT CONTROL + SPACEBAR.
The SuperNova control panel opens.
2. Press ALT + V.
The "Visual" menu opens.
3. DOWN ARROW to "Highlighting" and RIGHT ARROW to open the
sub-menu.
4. Use the Arrow Keys to select a scheme and press ENTER.
SuperNova applies the scheme.
5. To try a different scheme, repeat the steps above.
6. If no scheme is suitable then select the "Settings" option in the
"Highlighting" sub-menu. This opens the "Highlighting Options" dialog
box. In this dialog box you can create a custom scheme.
Tip: If you see no visual effect when choosing a scheme then check
to ensure "Highlighting" is turned on. You can turn Highlighting on by
selecting the "Highlighting" option in the "Visual" menu or by
selecting the "Highlighting" button in the "Visual" tab of the
SuperNova control panel.

5.3 Change the size and colour of the mouse pointer

Available with SuperNova are mouse pointers that are larger and easier to
see than the usual Windows mouse pointers. The pointers are available in
a range of different colours and sizes.
To select SuperNova mouse pointers:
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1. Press LEFT CONTROL + SPACEBAR. This will open the SuperNova
control panel.
2. Press ALT + V. This will open the "Visual" menu.
3. DOWN ARROW to "Mouse Pointers" and press ENTER. This will open
the "Mouse Pointers" dialog box.
4. Use the "Scheme" list to choose an existing set of mouse pointers. If no
existing scheme is suitable, use the other options to create a new
scheme.
5. TAB to the "OK" button and press SPACEBAR. This will confirm the
changes and close the dialog box.
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CHAPTER 6

Line View

Line View is a SuperNova reading mode. Line View shows the content of
the screen as a single line scrolling across the screen. You can control the
size, colours, font and the speed and position of the scrolling text.
Note: This feature is not supported if you are using Windows 8 or
later.

6.1 Start Line View
You can start Line View from the "Visual" options in the SuperNova control
panel or by using a hot key. Line View can start at the current focus
position or it can ignore the current focus in favour of displaying the current
window or screen.
Line View Hot Keys
Function

Start Line View (restricted to
document window)

Start Line View (restricted to
whole window)
Start Line View at current
focus position (restricted to
document window)
Start Line View at current
focus position (restricted to
whole window)

Desktop Default
NumPad Set
LEFT
CONTROL +
NUMPAD
PERIOD
LEFT
CONTROL +
NUMPAD 9
LEFT
CONTROL +
LEFT SHIFT +
NUMPAD 2
LEFT
CONTROL +
NUMPAD 2

Laptop Universal Set
No
Assignment

No
Assignment
ALT + SHIFT
+L

ALT + SHIFT
+V
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6.2 Scroll text in Line View
You use various hot keys to control how the content scrolls in Line View.
Line View Hot Keys
Function

Go to the Focus
Start and Stop
Go to the First line
Go to the Last Line
Previous Line
Next Line
Scroll Faster
Scroll Slower
Flip forward
Move Forward
Move Backwards
Exit Line View mode

Desktop Default
NumPad Set
NUMPAD 0
SPACEBAR
HOME
END
PAGE UP
PAGE DOWN
UP ARROW
DOWN
ARROW
ENTER
RIGHT
ARROW
LEFT ARROW
ESCAPE

Laptop Universal Set
F5
SPACEBAR
HOME
END
PAGE UP
PAGE DOWN
UP ARROW
DOWN
ARROW
ENTER
RIGHT
ARROW
LEFT ARROW
ESCAPE

Tip: Line View mode is restricted to what is visible on the screen. In some
applications it is possible to change the application's view settings to
increase the data visible at any one time. For example, in Microsoft Word
Print Preview it is possible to set the page view to a maximum of 6 pages.
All 6 pages will be scrolled in Line View mode.

6.3 Change the colour, font and items displayed in Line View
You can change the colours, fonts, objects and the size of the text shown in
Line View.
To go to the Line View options:
1. Press Left control + SPACEBAR. This will open the SuperNova control
panel.
2. Press ALT + V. This will open the "Visual" menu.
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3. DOWN ARROW to "Advanced Options" and press ENTER. This will
open the "Visual Advanced Options" dialog box.
4. CONTROL + TAB to open the "Line View " tab.
5. Make your changes.
6. TAB to the "OK" button and press SPACEBAR. This will confirm your
changes and close the dialog box.
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Doc Reader

The Doc Reader lets you create your own reading environment, where the
text, background and highlight can all be set to a value that makes reading
comfortable for you. You can display text from documents, web pages or
any other source showing text on the screen.

7.1 Launch Doc Reader
You can launch the Doc Reader by clicking the Doc Reader button on the
"Visual" page of the SuperNova control panel or by pressing a SuperNova
hot key.
Doc Reader Hot Keys
Function

Launch Doc Reader

Desktop Default
NumPad Set
CAPS LOCK +
NUMPAD
PLUS

Laptop Universal Set
ALT + SHIFT
+D

Your text will be loaded into the Doc Reader. This may take a few seconds.
In the Doc Reader, you can use the Arrow Keys to move the highlight
through the text or press TAB to move through the Doc Reader toolbar
options.

7.2 Control reading
The items available on the Doc Reader toolbar control the reading
environment. For advanced controls, including the colour settings, fonts
and reading speed please go to the "Doc Reader Settings" dialog box.
After launching the Doc Reader, you can access the toolbar options by
pressing TAB. Repeated presses of TAB will move you along the toolbar
options and finally return you to the document window. You can also use
SHIFT + TAB to navigate back across the toolbar buttons.
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Doc Reader toolbar.

You press this button to start or stop the reading of the document. You can
also start or stop the reading of the document by pressing SPACEBAR.
When reading, the Doc Reader highlights the current word and
automatically scrolls the document window.

You press this button to increase the size of the text. The change in the text
size is independent from the custom font options in the Doc Reader
Settings dialog box.

You press this button to shrink the size of the text. The change in the text
size is independent from the custom font options in the Doc Reader
Settings dialog box.

You press this button to open the "Highlight" menu, where you can select
between line, sentence and paragraph. The item selected determines
what is highlighted as a "unit" and the size of movement as you navigate up
and down through your text.

You press this button to open the "Mode" menu, where you can choose
between "Word wrap" or "Single line".

Doc Reader
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If you choose neither option then the line breaks will be determined by the
document itself. This can result in text scrolling outside the browser
window.

You press this button to open the "Doc Reader Settings" dialog box.
Options include setting the foreground and background colour, font to use,
how the document is loaded and reading speed.

7.3 Exit Doc Reader
To do this:
Press ESCAPE.
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CHAPTER 8

Bookshelf

You can use Bookshelf to search for and download books and magazines
from online libraries and to browse news feeds, listen to radio stations and
play popular podcasts.
IMPORTANT: The options available in Bookshelf will differ
depending on your SuperNova Control Panel language.

8.1 Bookshelf Books
You can use the "Books" option to search for, download and open books
and magazines from online libraries. You can also use this option to open
files on the computer. The books and files you select open in the
SuperNova Reader.
8.1.1 Open a file in the SuperNova Reader:
You can use Bookshelf to open files on the computer. The file formats you
can open include text files, EPUB files, daisy FILES, html FILES and PDF
files. The files will open in the SuperNova Reader.
To open a file from the SuperNova Control Panel:
1. Press ALT + O.
The Bookshelf" menu opens.
2. DOWN ARROW to "Books" and RIGHT ARROW.
A submenu opens.
3. DOWN ARROW to "Open File In Reader" and press ENTER.
The "Open" dialog box opens. By default, the explorer window
shows PDF documents present in the folder. If you want to open
alternative file types you must change the file type setting.
4. SHIFT + TAB into the file list, use the Arrow Keys to select the file and
then press ENTER. If the file is in a different folder, use BACKSPACE
to go one level up and use ENTER to open folders until you select the
file and then press ENTER.
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A dialog box opens giving you the chance to change the
converted file's name and, if possible, specify particular page
ranges.

5. If you wish to make changes to the default settings, TAB through and
make the changes.
6. When done, TAB to the "OK" button and press SPACEBAR.
A message window opens showing the progress of the conversion.
When the conversion is complete the book opens in the
SuperNova Reader.
7. When you have finished reading the text, press ALT + F4 to close the
window.
8.1.2 Open a book from an online library
You can use Bookshelf to download and open books from online libraries.
The files will open in the SuperNova Reader.
To open a file from the SuperNova control panel:
1. Press ALT + O.
The Bookshelf" menu opens.
2. DOWN ARROW to "Books" and RIGHT ARROW.
A submenu opens.
3. DOWN ARROW to "Online Books" and press ENTER.
The Bookshelf dialog box opens showing a list of available
libraries. Note that some libraries may require you to register with
them before you can download a book. If you want to use the
services of these libraries then you must first contact the library to
register with them and obtain user account details.
4. Use the Arrow Keys to select a library and press ENTER.
Depending on the library, you will typically find a category list
opens giving you further options to narrow down the list of books
to be shown. This can sometimes be followed by a third and fourth
list of subcategories.
5. If you want to browse the available books, use the Arrow Keys to select
a category and press ENTER. Repeat the process until you find the list
of books of interest. Alternatively, if you know the title of the book you
want to read, TAB to the "Search" box, type in a key word and press
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ENTER. SuperNova will search the library for matches and list the
results.
6. DOWN ARROW to select a book and press ENTER.
A dialog box opens. The focus is on the "Download" button.
7. Press SPACEBAR to begin the download.
8. When the download is complete, do one of the following:
If you want to read the book, TAB to the "Read now" button and
press SPACEBAR. The book opens in the SuperNova Reader. When
you have finished reading the text, press ALT + F4 to close the
window.
If you want to copy the book to a portable device, ensure you have a
portable device connected to the computer and then TAB to the
"Send To" button and press SPACEBAR. A dialog box opens listing
the drives you can copy the book to. Select the drive and press
ENTER. A confirmation message will appear when the process is
complete.
If you want to remove the book from the computer, TAB to the
"Delete" button and press SPACEBAR. A message window opens
asking you to confirm the action. Choose "Yes" to delete the book.
8.1.3 Open the last book you were reading
SuperNova remembers the last book you were reading. You can go back to
reading this book using the options available in Bookshelf.
To open the last book you were reading from the SuperNova control panel:
1. Press ALT + O.
The Bookshelf" menu opens.
2. DOWN ARROW to "Books" and RIGHT ARROW.
A submenu opens. The first item is "Continue reading...". followed
by the title of the book.
3. Press ENTER.
The book opens in the SuperNova Reader. You will be positioned
at the last place you were reading in the book.
4. When you have finished reading the text, press ALT + F4 to close the
window.

50

Bookshelf

8.1.4 Open, copy or delete an existing book
You can open, copy and delete books you download from online libraries.
To do this from the SuperNova control panel:
1. Press ALT + O.
The Bookshelf" menu opens.
2. DOWN ARROW to "Books" and RIGHT ARROW.
A submenu opens.
3. DOWN ARROW to "My Books" and press ENTER.
A list opens showing available books.
4. DOWN ARROW to the book you want to open, copy or delete and
press ENTER.
A dialog box opens.
5. Do one of the following:
If you want to read the book, TAB to the "Read now" button and
press SPACEBAR. The book opens in the SuperNova Reader. When
you have finished reading the text, press ALT + F4 to close the
window.
If you want to copy the book to a portable device, ensure you have a
portable device connected to the computer and then TAB to the
"Send To" button and press SPACEBAR. A dialog box opens listing
the drives you can copy the book to. Select the drive and press
ENTER. A confirmation message will appear when the process is
complete.
If you want to remove the book from the computer, TAB to the
"Delete" button and press SPACEBAR. A message window opens
asking you to confirm the action. Choose "Yes" to delete the book.

8.2 Bookshelf News, Radio Stations and Podcasts
You can use Bookshelf's "News", "Radio Stations" and "Podcasts" to keep
up-to-date with the latest news and entertainment available on the Internet.
IMPORTANT: Some content requires RealPlayer to be installed. If
you do not have support for this content then SuperNova displays a
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warning message. The message includes links to web sites where
you can download the necessary files.

8.2.1 Read a news article
You can open, browse and read popular news articles available on the
Internet using Bookshelf.
To do this from the SuperNova control panel:
1. Press ALT + O.
The "Bookshelf" menu opens.
2. DOWN ARROW to "Newss" and press ENTER.
A list of popular news feeds opens.
3. Use the Arrow Keys to select a feed and press ENTER.
A list of news headlines opens.
4. Use the Arrow Keys to select a headline and press ENTER.
The dialog box closes and the news article opens in a web
browser.
8.2.2 Listen to a radio station
You can listen to popular radio stations available on the Internet using
Bookshelf.
To do this from the SuperNova control panel:
1. Press ALT + O.
The "Bookshelf" menu opens.
2. DOWN ARROW to "Radio" and press ENTER.
A list of popular radio stations opens.
3. Use the Arrow Keys to select a radio station and press ENTER.
The dialog box closes and the radio station begins to play in an
associated media player, for example, Windows Media Player.
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8.2.3 Listen to a podcast
You can listen to popular podcasts available on the Internet using
Bookshelf.
To do this from the SuperNova control panel:
1. Press ALT + O.
The "Bookshelf" menu opens.
2. DOWN ARROW to "Podcasts" and press ENTER.
A list of popular podcasts opens.
3. Use the Arrow Keys to select a podcast and press ENTER.
The dialog box closes and the podcast begins to play in an
associated media player, for example, Windows Media Player.
8.2.4 Adjust the favourite news, radio station and podcast listings
You can add, remove and organise the news, radio stations and podcast
listings in Bookshelf.
To do this from the SuperNova control panel:
1. Press ALT + O.
The "Bookshelf" menu opens.
2. Use the Arrow Keys to select a web service, for example, "News",
"Radio" or "Podcast" and press ENTER.
A list opens showing available services.
3. Do one of the following:
To add a service, TAB to the "Add" button and press SPACEBAR.
This opens a new dialog box containing a list of the services you can
add and a list of the currently available services. Use the Arrow Keys
to select a service to add and then TAB to the "Add" button and press
SPACEBAR to add the service to the list of available services.
Repeat the steps for each service you want to add.
To remove a service, use the Arrow Keys to select the service, then
TAB to the "Remove" button and press SPACEBAR. Repeat the
steps for each service you want to REMOVE.
To organise the list of services, use the Arrow Keys to select a
service and then TAB to the "Up" or "Down" button and press
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SPACEBAR. This will move the item higher or lower down the list of
services. Continue to press the button until you position the item in
the list where you want it to be placed.
4. When done, TAB to the "Close" button and press SPACEBAR.

8.3 SuperNova Reader keyboard commands
The books you open from the Bookshelf appear as an HTML page in the
SuperNova Reader. This allows you to read and navigate the book in the
same way you read web pages.
In addition, SuperNova includes the following keyboard commands:
Function
Hot key
Move between document
F6
window and toolbar
Move between the buttons on
TAB and SHIFT + TAB
the toolbar
Play / stop (only available if book F5
has audio content)
Open Content
ALT + C
Open Settings
ALT + S
Zoom In
ALT + I
Zoom Out
ALT + O
Exit
ALT + E (or ALT + F4)
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CHAPTER 9

Settings Files

9.1 Create Application Settings
If you find you regularly adjust SuperNova output settings when working in
different programs, then using Application Settings can provide an
automated solution.
To create an Application Settings file:
1. Run the application you want to create an Application settings file for.
2. Press LEFT CONTROL + SPACEBAR. This will open the SuperNova
control panel.
3. Press ALT + F. This will open the "File" menu with "New" selected.
4. RIGHT ARROW into the "New" sub-menu.
5. Select "Application settings" and press ENTER. This will open the
"Select Settings file" dialog box.
6. Select "Create a new settings file".
7. TAB to the "OK" button and press SPACEBAR. This will open the
"Create new Settings File" dialog box.
8. Give the new Application Settings file a name, choose whether to create
an empty settings file or copy an existing settings file and then TAB to
the "OK" button and press SPACEBAR. This will close the dialog box
and return you to the SuperNova control panel.
Your Application Settings file will now be in use. You can check the
Application Settings file currently in use by reading the Status Bar in the
SuperNova control panel.

9.2 Create Situation Settings
If you find you regularly adjust SuperNova output settings when certain
dialog boxes appear in an application then using Situation Settings can
provide an automated solution. Situation Settings are a subset of
Application Settings and are stored within the same file.
To create a Situation Setting:
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1. Run the application and get into the situation you want to create a
Situation Setting for.
2. Press LEFT CONTROL + SPACEBAR. This will open the SuperNova
control panel.
3. Press ALT + F. This will open the "File" menu with "New" selected.
4. RIGHT ARROW into the "New" sub-menu.
5. Select "Situation settings" and press ENTER. This will open the "New
Situation Settings" dialog box.
6. Select "Create new Situation".
7. TAB to the "OK" button and press SPACEBAR. This will open the
"Enter a name for the new Situation" dialog box.
8. Give the new Situation Setting a name and then TAB to the "OK" button
and press SPACEBAR. This will open the "Windows Name" dialog box.
9. If required, adjust the Window Name and then TAB to the "OK" button
and press SPACEBAR. This will close the dialog box and return you t
the SuperNova control panel.
Your Situation Setting will now be in use. You can check the Situation
Setting currently in use by reading the Status Bar in the SuperNova control
panel.

9.3 Save setting changes
SuperNova automatically saves the changes you make to SuperNova
settings.
To stop this behaviour, deselect the "Always save user settings" check box.
You can find the "Always save user settings" check box in the "Startup
Preferences" dialog box, which you open through the "General" menu of
the SuperNova control panel.
After deselecting the "Always save user settings" check box, an additional
"Ask user" check box becomes available. If you select this check box then
you will receive a message window during the quitting of SuperNova that
asks if you want to proceed without saving the changes you have made.
You can also manually save settings at any time by choosing the "Save
Settings" menu item. You can find this item in the "File" menu in the
SuperNova control panel.
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9.4 Change Map file
If you are using an application that does not have a specific Map file then
SuperNova will use the "Default Application" Map file.
If you find SuperNova does not work well with your application using the
"Default Application" Map file then it is worth trying another Map file. You
can try as many Map files as you like.
Tips:
 Try using a Map file for a different version of the same application.
You may find a Map file for an old version of an application will work
just as well with a new version of the application.
 Try using a Map file created for an application from the same
manufacturer. You may find a Map file for a different application but
created by the same manufacturer will work well with your application,
for example, if you are using a Microsoft application try using the
Microsoft Office Map file.
 Try using the "MSAA Application" Map file if you know your application
supports MSAA.
To choose a different Map file:
1. Run your application.
2. Press LEFT CONTROL + SPACEBAR.
The SuperNova control panel opens.
3. Press ALT + F.
The "File" menu opens with the "New" menu item selected.
4. RIGHT ARROW to open the "New" sub-menu, DOWN ARROW to
"Map" and press ENTER.
The "Select Map file" dialog box opens.
5. DOWN ARROW to select the "Use an existing Map file" option.
6. TAB to the Map list and use the Arrow Keys to select a Map file.
7. TAB to the "OK" button and press SPACEBAR.
The dialog box closes.
8. Press ESCAPE.
The SuperNova control panel closes and you go back to the
application.
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The new Map file's detection settings will take effect immediately. If you
continue to have problems accessing your application then please contact
Dolphin or your local Dolphin Dealer for assistance.
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CHAPTER 10

Touchscreen

10.1 Touchscreen terminology
The following table provides a description of touchscreen gestures and
what the gesture means.
Gesture
Tap

Press and hold

Swipe
Slide

Pinch

How to do it
Tap the screen to
perform an action, for
example, tap a button
to activate the button.
Some gestures may
require you to tap the
screen with 1, 2, 3 or
more fingers multiple
times.
Press a finger on the
screen and continue to
hold the finger against
the screen.
A flick of a finger
across the screen.
A longer slower
movement of a finger
across the screen
usually in a vertical or
horizontal direction
from the screen edge.
Press two fingers on
the screen and move
them together, as if
you are pinching them
together.
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Stretch

Press two fingers on
the screen and move
them away from each
other, as if you are
stretching them apart.

10.2 Touchscreen gestures
The following table provides a list of the touchscreen gestures you can use
to control SuperNova.
Function
Toggle magnification
Increase magnification
Reduce magnification
Pan
Show / hide the SuperNova
Touch Bar

Gesture
3 finger double tap
2 finger stretch
2 finger pinch
1 finger swipe
3 finger single tap

More gestures.
In addition to the SuperNova touchscreen gestures, here are some more
touchscreen gestures to help you get around Windows.
Function
Open the Charms (Search,
Share, Start, Devices, Settings).
Switch apps
Open the App Menu. The App
Menu shows commands like
Save, Edit and Delete.
Close the open app

Gesture
Slide in from over the
right edge with 1 finger
Swipe in from over the
left edge with 1 finger.
Slide in from over the
bottom edge with 1
finger.
Slide in from over the
top edge with 1 finger
and continue the
motion, dragging the
app down to the
bottom of the screen.

Touchscreen
Open the context menu (this is
the same as performing a right
click on a selected item)
Drag and drop objects around
the screen, for example, when
re-arranging the Start Screen or
desktop.
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1 finger double tap,
hold and release.
1 finger double tap and
hold, then slide to
move the object. Lift
finger to release.

10.3 SuperNova Touch Bar
The SuperNova Touch Bar is a touchscreen toolbar that appears at the
bottom of the screen when you do a 3 finger single tap. The Touch Bar
gives you access to the most common SuperNova actions including turning
magnification on and off, changing magnification size and turning the
SuperNova Colour Scheme on and off.

10.4 Typing on a touchscreen
SuperNova automatically shows an onscreen keyboard when you need to
type and you do not have a keyboard connected to the device. The
onscreen keyboard appears at the bottom of the screen and uses large
print high contrast keys.
You can also make the keyboard appear at any time by tapping the
Keyboard button in the SuperNova Touch Bar or by tapping the Keyboard
button in the Windows Notification area. To hide the keyboard, tap the large
"X" button in the bottom right corner of the onscreen keyboard.
You can adjust the appearance of the onscreen keyboard in the
Touchscreen Settings dialog box.

10.5 Adjust touch sensitivity
You can adjust how sensitive SuperNova is to your taps and swipes on the
touchscreen.
For example, If you find that SuperNova is interpreting a double tap gesture
as two single tap gestures then you may need to increase the double-tap
timeout”. In the same way, if you find that when attempting to drag and
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drop a desktop icon the icon is not being picked up, then you may need to
increase the double-tap timeout or the pass-through timeout”.
You make the changes to SuperNova's touchscreen settings in the
Touchscreen dialog box.
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CHAPTER 11

Hot key conflicts

Sometimes you can find SuperNova hot keys conflict with an application's
hot keys. You can resolve this issue in a number of different ways.

11.1 Turn off SuperNova hot keys
You can resolve a hot key conflict between SuperNova and your
application by turning off SuperNova's hot keys. This disables all hot keys
except for the hot key to turn on SuperNova's hot keys again.
Action Hot Keys
Function

Turn off or on hot keys

Desktop Default
NumPad Set
LEFT
CONTROL + 8

Laptop Universal Set
SHIFT +
CAPS LOCK +
3

11.2 Tell SuperNova to ignore the next key press
You can resolve a hot key conflict between SuperNova and your
application by telling SuperNova to ignore the next key press. Once you
have released the keys, SuperNova automatically turns on its hot keys
again.
Action Hot Keys
Function

Pass the next key press
through to your application

Desktop Default
NumPad Set
LEFT
CONTROL + 7

Laptop Universal Set
CAPS LOCK +
3
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11.3 Reassign a SuperNova hot key
You can add, delete or reassign any SuperNova hot key. You can do this to
resolve hot key conflicts between SuperNova and your application or to
change a hot key command to a key combination you find easier to use.
To do this:
1. Press LEFT CONTROL + SPACEBAR.
The SuperNova control panel opens.
2. Press ALT + G.
The "General" menu opens.
3. DOWN ARROW to "Keyboard and Hot Keys" and press ENTER.
A submenu opens.
4. DOWN ARROW to "Hot Keys" and press ENTER.
The "Hot Keys" dialog box opens.
5. TAB through, using the "Hot Key Command Set" list and "Command"
list to select the assigned hot key you want to change.
6. Use the "Add key" button, "Replace key" button or "Remove key" button
to change the hot key.
7. TAB to the "OK" button and press SPACEBAR.
SuperNova confirms the changes and closes the dialog box.
Tip: If you find it difficult to locate your hot key from the categories
and commands available then use the SuperNova Key Describer to
help.
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CHAPTER 12

Hot Keys

12.1 Actions
Function

Control Panel Pop Up Menu
Doc Reader
SuperNova Help

Hot Keys on / off
Open Control Panel

Pass next key to application
Quit
Row / Column Mode Toggle
Screen Refresh

Desktop Default
NumPad Set
CAPS LOCK +
SPACEBAR
SHIFT + ALT +
D
CAPS + F1
or RIGHT
CONTROL +
RIGHT SHIFT +
FORWARD
SLASH
LEFT
CONTROL + 8
LEFT
CONTROL +
SPACEBAR
LEFT
CONTROL + 7
CAPS LOCK +
F4
LEFT
CONTROL + 9
LEFT
CONTROL +
SEMI COLON

Laptop Universal Set
CAPS LOCK +
SPACEBAR
CAPS LOCK +
F11
CAPS + F1

SHIFT + CAPS
LOCK + 3
LEFT
CONTROL +
SPACEBAR
CAPS LOCK +
3
CAPS LOCK +
F4
No Assignment
CAPS LOCK +
ESCAPE
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12.2 Magnifier
Function

Colour Scheme on off

Create Hooked Area

Foci Highlights on off

Hooked areas on off

Jump Down

Jump Left

Jump Right

Jump Up

Magnification Decrease

Desktop Default
NumPad Set
LEFT
CONTROL +
NUMPAD 0
LEFT
CONTROL +
NUMPAD 5
LEFT
CONTROL +
LEFT SHIFT +
BACK SLASH
LEFT
CONTROL +
NUMPAD 3
LEFT
CONTROL +
CAPS LOCK +
NUMPAD 2
LEFT
CONTROL +
CAPS LOCK +
NUMPAD 4
LEFT
CONTROL +
CAPS LOCK +
NUMPAD 6
LEFT
CONTROL +
CAPS LOCK +
NUMPAD 8
LEFT
CONTROL +
NUMPAD
MINUS
or CAPS LOCK
+ MOUSE
WHEEL DOWN

Laptop Universal
SHIFT + ALT +
C
LEFT SHIFT +
LEFT
CONTROL +
ALT + H
LEFT SHIFT +
LEFT ALT + O

No Assignment

LEFT ALT +
PAGE DOWN

LEFT ALT +
HOME

LEFT ALT +
END

LEFT ALT +
PAGE UP

LEFT ALT +
MINUS
or CAPS LOCK
+ MOUSE
WHEEL DOWN

Hot Keys
Magnification Increase

Magnification X Decrease

Magnification X Increase

Magnification Y Decrease

Magnification Y Increase

Magnifier on off

Modify Hooked Areas

Modify Primary Area

Move Down

Move Left

LEFT
CONTROL +
NUMPAD
PLUS
or CAPS LOCK
+ MOUSE
WHEEL UP
RIGHT
CONTROL +
NUMPAD
SLASH
LEFT
CONTROL +
NUMPAD
SLASH
RIGHT
CONTROL +
NUMPAD
STAR
LEFT
CONTROL +
NUMPAD
STAR
LEFT
CONTROL +
NUMPAD
ENTER
LEFT
CONTROL +
NUMPAD 6
LEFT
CONTROL +
NUMPAD 4
RIGHT
CONTROL +
RIGHT SHIFT +
DOWN
ARROW
RIGHT
CONTROL +
RIGHT SHIFT +
LEFT ARROW

LEFT ALT +
EQUALS
or CAPS LOCK
+ MOUSE
WHEEL UP

No Assignment

No Assignment

No Assignment

No Assignment

ALT + 0

LEFT SHIFT +
ALT + H
LEFT SHIFT +
ALT + A
RIGHT
CONTROL +
RIGHT SHIFT +
DOWN
ARROW
RIGHT
CONTROL +
RIGHT SHIFT +
LEFT ARROW
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Move Right

Move to bottom left of screen

Move to bottom of screen

Move to bottom right of
screen
Move to left edge of screen

Move to middle of screen

Move to right edge of screen

Move to top left of screen

Move to top of screen

Move to top right of screen

Move Up

Orientation Cycle

Overview mode on off

RIGHT
CONTROL +
RIGHT SHIFT +
RIGHT
ARROW
RIGHT
CONTROL +
NUMPAD 1
RIGHT
CONTROL +
NUMPAD 2
RIGHT
CONTROL +
NUMPAD 3
RIGHT
CONTROL +
NUMPAD 4
RIGHT
CONTROL +
NUMPAD 5
RIGHT
CONTROL +
NUMPAD 6
RIGHT
CONTROL +
NUMPAD 7
RIGHT
CONTROL +
NUMPAD 8
RIGHT
CONTROL +
NUMPAD 9
RIGHT
CONTROL +
RIGHT SHIFT +
UP ARROW
LEFT
CONTROL +
NUMPAD 1
LEFT
CONTROL +
BACK SLASH

RIGHT
CONTROL +
RIGHT SHIFT +
RIGHT
ARROW
No Assignment

No Assignment

No Assignment

No Assignment

No Assignment

No Assignment

No Assignment

No Assignment

No Assignment

RIGHT
CONTROL +
RIGHT SHIFT +
UP ARROW
No Assignment

No Assignment

Hot Keys
Pan Down

Pan Left

Pan Right

Pan Up

Primary Magnifier Type Cycle

Restore Position

Save Position

Switch monitors

Text smoothing on off

RIGHT
CONTROL +
DOWN
ARROW
RIGHT
CONTROL +
LEFT ARROW
RIGHT
CONTROL +
RIGHT
ARROW
RIGHT
CONTROL +
UP ARROW
LEFT
CONTROL +
NUMPAD 7
RIGHT
CONTROL +
NUMPAD
PERIOD
RIGHT
CONTROL +
NUMPAD 0
CAPS LOCK +
MIDDLE
MOUSE
BUTTON
LEFT
CONTROL +
NUMPAD 8

RIGHT
CONTROL +
DOWN
ARROW
RIGHT
CONTROL +
LEFT ARROW
RIGHT
CONTROL +
RIGHT
ARROW
RIGHT
CONTROL +
UP ARROW
LEFT SHIFT +
ALT + M
No Assignment

No Assignment

CAPS LOCK +
MIDDLE
MOUSE
BUTTON
No Assignment

12.3 Magnifier Window Adjustment
Function

Alter hook with mouse
Area Down

Desktop Default
NumPad Set
LEFT MOUSE
BUTTON
DOWN
ARROW

Laptop Universal Set
LEFT MOUSE
BUTTON
DOWN
ARROW
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Area Left
Area Right
Area Up
Cancel Get Hook Area
Contents Down

Contents Left
Contents Right

Contents Up
Cycle Orientation

Decrease Magnification

Decrement X Magnification

Decrement Y Magnification

Delete Hooked Area
Exit Modification Mode
Increase Magnification

LEFT ARROW
RIGHT
ARROW
UP ARROW
ESCAPE
LEFT SHIFT +
DOWN
ARROW
LEFT SHIFT +
LEFT ARROW
LEFT SHIFT +
RIGHT
ARROW
LEFT SHIFT +
UP ARROW
LEFT
CONTROL +
NUMPAD 1
LEFT
CONTROL +
NUMPAD
MINUS
or CAPS LOCK
+ MOUSE
WHEEL DOWN
RIGHT
CONTROL +
NUMPAD
SLASH
RIGHT
CONTROL +
NUMPAD
STAR
DELETE
ESCAPE
LEFT
CONTROL +
NUMPAD
PLUS
or CAPS LOCK
+ MOUSE
WHEEL DOWN

LEFT ARROW
RIGHT
ARROW
UP ARROW
ESCAPE
LEFT SHIFT +
DOWN
ARROW
LEFT SHIFT +
LEFT ARROW
LEFT SHIFT +
RIGHT
ARROW
LEFT SHIFT +
UP ARROW
No Assignment

ALT + MINUS
or CAPS LOCK
+ MOUSE
WHEEL DOWN

No Assignment

No Assignment

DELETE
ESCAPE
ALT + EQUALS
or CAPS LOCK
+ MOUSE
WHEEL UP

Hot Keys
Increment X Magnification

Increment Y Magnification

Make narrower

Make shorter

Make taller

Make wider

Move area with mouse
Move contents of area with
mouse
OK Get Hook Area

Resize area with mouse
Text Smoothing

Tracking on off

LEFT
CONTROL +
NUMPAD
SLASH
LEFT
CONTROL +
NUMPAD
STAR
LEFT
CONTROL +
LEFT ARROW
LEFT
CONTROL +
UP ARROW
LEFT
CONTROL +
DOWN
ARROW
LEFT
CONTROL +
RIGHT
ARROW
Z
C
ENTER
or RIGHT
MOUSE
BUTTON
X
LEFT
CONTROL +
NUMPAD 8
LEFT SHIFT +
NUMPAD 8

No Assignment

No Assignment

LEFT
CONTROL +
CLEFT
ARROW
LEFT
CONTROL +
UP ARROW
LEFT
CONTROL +
DOWN
ARROW
LEFT
CONTROL +
RIGHT
ARROW
Z
C
ENTER
or RIGHT
MOUSE
BUTTON
X
No Assignment

No Assignment
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12.4 Line View
Function

Decrease magnification

Decrement X magnification

Decrement Y magnification

Exit Line View
Exit Line View and click at
character or route Dolphin
Cursor to character
Flip forward
Go to the first line
Go to the focus
Go to the last line
Increase magnification

Increment X magnification

Desktop Default
NumPad Set
LEFT
CONTROL +
NUMPAD
MINUS
or CAPS LOCK
+ MOUSE
WHEEL DOWN
RIGHT
CONTROL +
NUMPAD
SLASH
RIGHT
CONTROL +
NUMPAD
STAR
ESCAPE
NUMPAD
ENTER

ENTER
HOME
NUMPAD 0
END
LEFT
CONTROL +
NUMPAD
PLUS
or CAPS LOCK
+ MOUSE
WHEEL UP
LEFT
CONTROL +
NUMPAD
SLASH

Laptop Universal Set
ALT + MINUS
or CAPS LOCK
+ MOUSE
WHEEL DOWN

No Assignment

No Assignment

ESCAPE
ENTER
or LEFT
MOUSE
BUTTON
ENTER
HOME
F5
END
ALT + EQUALS
or CAPS LOCK
+ MOUSE
WHEEL UP

No Assignment

Hot Keys
Increment Y magnification

LEFT
CONTROL +
NUMPAD
STAR
Line View document
LEFT
CONTROL +
NUMPAD
PERIOD
Line View document area and LEFT
go to focus
CONTROL +
LEFT SHIFT +
NUMPAD 2
Line View document from
LEFT
cursor
CONTROL +
NUMPAD 2
Line View whole window
LEFT
CONTROL +
NUMPAD 9
Move backwards
LEFT ARROW
Move forward
RIGHT
ARROW
Next line
PAGE DOWN
Previous line
PAGE UP
Scroll faster
UP ARROW
Scroll slower
DOWN
ARROW
Start or stop
SPACEBAR
Text smoothing
LEFT
CONTROL +
NUMPAD 8

No Assignment

No Assignment

No Assignment

LEFT SHIFT +
ALT + L
LEFT SHIFT +
ALT + V
LEFT ARROW
RIGHT
ARROW
PAGE DOWN
PAGE UP
UP ARROW
DOWN
ARROW
SPACEBAR
No Assignment

12.5 Item Finder
Function

Item Finder (multi tab dialog
box)
Links

Desktop Default
NumPad Set
CAPS LOCK +
TAB
CAPS LOCK +
1

Laptop Universal Set
CAPS LOCK +
TAB
CAPS LOCK +
F7
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Headings
Frames or Objects
Tables
Controls
Revisions or Comments

Errors

CAPS LOCK +
2
CAPS LOCK +
3
CAPS LOCK +
5
CAPS LOCK +
6
CAPS LOCK +
7
CAPS LOCK +
8

CAPS LOCK +
F6
CAPS LOCK +
F9
No Assignment
CAPS LOCK +
F5
LEFT SHIFT +
CAPS LOCK +
R
No Assignment

12.6 Quick Navigation Keys for Microsoft Word
SuperNova coding includes the following list of hot keys for supported
versions of Microsoft Word. You cannot remove or reassign these keyboard
commands.
12.6.1 Quick Navigation Keys
To move to the previous element use Shift + Caps Lock + Key
Move to
Hot key
Bookmark
CAPS LOCK + A
Button
CAPS LOCK + B
Comment
CAPS LOCK + C
Different paragraph style
CAPS LOCK + D
Edit form field
CAPS LOCK + E
Footnote or Endnote
CAPS LOCK + F
Graphic
CAPS LOCK + G
Heading style
CAPS LOCK + H
List item
CAPS LOCK + I
Link
CAPS LOCK + K
List
CAPS LOCK + L
Text box
CAPS LOCK + M
Normal style paragraph
CAPS LOCK + N
Object (including graphics)
CAPS LOCK + O
Paragraph
CAPS LOCK + P

Hot Keys
Revision
Table
Check box
Section break
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CAPS LOCK + R
CAPS LOCK + T
CAPS LOCK + X
CAPS LOCK + Z

Note that you may find various Quick Navigation Keys failing when working
in a protected document.
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Reference

13.1 New Situation Settings dialog box
Menu: File > New > Situation Settings

You can create or choose an existing Situation by using options in the
"New Situation Settings" dialog box.
Options:
 Create New Situation radio button.
You can create a new Situation Setting by selecting this radio button
and then choosing the "OK" button. This will move you to the next
step in the creation process. To review all steps in this process please
refer to the "Create Situation Settings" topic.
 Use an existing Situation radio button.
You can change to another Situation by selecting this option and then
selecting from the available list. Note the Situation list will show only
those Situation Settings available in the current Application Settings
file.

13.2 New Application Settings dialog box
Menu: File > New > Application Settings

You can create or choose an existing Application Settings file by using
options in the Application Settings dialog box.
Options:
 Create a new settings file radio button.
You can create a new Application Settings file by selecting this option
and then choosing the "OK" button. After selecting the "OK" button,
you will go to the next step in the creation process. To review all steps
in this process please refer to the "Create Application Settings" topic.
 Use an existing settings file radio button.
You can change to a different settings file by selecting this option and
then by selecting a file from the available list. You confirm your
selection by choosing the "OK" button. The settings will apply
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immediately unless you select the option "Use Default Settings in the
control panel". If you do select this option then your new settings will
apply when you go back to your application.

13.3 New Map dialog box
Menu: File > New > Map

You can create or choose an existing Map file by using options in the
"Select New Map" dialog box.
Options:
 Create a new Map file radio button.
You can create a new Map file by selecting this radio button and then
choosing the "OK" button. This will move you to the next step in the
creation process. To review all steps in this process please refer to
the "Mapping Guide". This is available through the SuperNova "Help"
menu.
 Use an existing Map file radio button.
You can change to an alternative Map file by selecting this option and
then selecting a file from the available list. To learn more about the
reasons why you might change a Map file please refer to the "Change
Map file" topic.

13.4 New Script menu item
Menu: File > New > Script

You can create a new Script file for the current application by selecting this
menu item. The new Script file will open in the Dolphin Script Editor. The
Dolphin Script Editor includes a "Help" menu with options linking to the
Scripting Guide.
Note: If a Script file exists for the current application then this menu
item will be disabled. To view and edit an existing Script file, go to
the "File" menu, "Edit" sub-menu and select "Script".

13.5 Edit Situation Settings dialog box
Menu: File > Edit > Situation Settings

You can delete or change the properties of your Situation Settings by using
options in the "Situation Management" dialog box. Note that you must be
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using the Application Settings file that has the Situation Settings to be able
to edit the Situations in that file.
 Situation list.
You can choose the Situation you want to edit or delete from this list.
 Edit Rules button.
You can edit the rules of a Situation by selecting this button. This will
open the "Define Situation Rules" dialog box. In this dialog box you
can change the name of the Situation, change the title and class
details of the Situation rule and add and remove Situation rules.
 Delete button.
You can delete the current Situation from your Application Settings file
by selecting this button. After selecting the button you will receive a
warning message asking you to confirm that you want to proceed. To
proceed select the "Yes" button or to cancel select the "No" button.

13.6 Edit Application Settings dialog box
Menu: File > Edit > Application Settings

You can delete or change the properties of your Application Settings file by
using options in the "Settings File Management" dialog box.
 Application Settings file list.
You can choose the Application Settings file you want to edit or delete
from this list. Note that you cannot delete the "Default Application"
settings file because this is a SuperNova system file.
 Properties button.
You can edit the properties of an Application Settings file by selecting
this button. This will open the "Settings File Properties" dialog box.
In this dialog box you can change the name and version number of
the settings file and add and remove any the applications associated
with the file.
 Delete this settings file button.
You can delete the current Application Settings file by selecting this
button. After selecting the button you will receive a warning message
asking you to confirm that you want to proceed. To proceed select the
"Yes" button or to cancel select the "No" button.
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13.7 Edit Map dialog box
Menu: File > Edit > Map

You can edit the properties and rules of a Map file by selecting this menu
item. To learn more about Map files please refer to the Mapping Guide
available from the "Help" menu of the SuperNova control panel.
This dialog box also contains Script options. You can create, reload, edit
and delete Script files and Extension Script files. To learn more about
Script files please refer to the Scripting Guide. You can open the Scripting
Guide from the SuperNova control panel "Help" menu.

13.8 Edit Script menu item
Menu: File > Edit > Script

You can edit the Script file for the current application by selecting this menu
item. The Script file will open in the Dolphin Script Editor. The Dolphin
Script Editor includes a "Help" menu with options linking to the Scripting
Guide.
Note: If no Script file exists for the current application then this menu
item will be disabled. To create a new Script file, go to the "File"
menu, "New" sub-menu and select "Script".

13.9 Visual Configure Custom Colour Scheme dialog box
Menu: Visual > Colour Schemes > Configure.

You can create your own colour scheme by using options in the "Configure
Custom Colour Scheme" dialog box.
Note: To open this dialog box you must choose "Custom" as your
Colour Scheme and then choose "Configure" from the list of Colour
Schemes.
 Invert brightness check box.
This option inverts the brightness of the screen, turning a typically
dark on light screen to a light on dark screen. This option does not
affect screen colours or saturation level.
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 Contrast slider and Brightness slider.
The "Contrast" slider and "Brightness" slider change the screen in a
similar way to the Contrast and Brightness buttons you find on a
television.
 Classic options.
You can use the "Colour" slider to control the amount of colour on the
screen. You can use the "Colour Adjust" slider to change the amount
of colour on the screen without changing the brightness.
 Tint options.
You can choose to apply a tint to the screen. This can be a single,
double or triple tint colour, which you choose from the available lists. .
If no colour is suitable then you can select "Custom" from the list,
which opens a colour palette offering more colours. With the tint
options, you also have the option to set the level of colour saturation.
You do this by adjusting the "Level" slider.
 Colour Replace options.
You can use the "Colour Replace" options to replace one screen
colour with another screen colour, for example, you may wish to
replace red with blue if you have difficulty viewing red text.
 Preview these colour settings when in this dialog box check box.
Select this check box to see your changes occur as you make them.

13.10 Visual Highlighting Options dialog box
Menu: Visual > Highlighting > Settings

You can make different types of focus easier to see by adding a highlight
indicator. You can choose the style, colour and behaviour of the highlight in
the "Highlighting Options" dialog box.
Mouse tab.
 Highlight the mouse check box.
Select this check box to turn on the highlighting of this focus. Deselect
this check box to turn off the highlighting of this focus.
 Display group.
Use the "Shape" settings to change the shape and size of the
highlighting.
Use the "Show" list box to control when the highlight is visible. Note
that selecting "On hot key" means you control the highlight using the
Foci Highlights hot key and selecting "Dynamic tracking" means the
mouse highlight stays visible until you press a key on the keyboard.
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 Effects group.
You can choose from different colour options. Depending on the
option you choose you can also control the colour(s) and/or the
transparency.
Cursor tab.
 Highlight the Cursor check box.
Select this check box to turn on the highlighting of this focus. Deselect
this check box to turn off the highlighting of this focus.
 Display group.
Use the "Shape" settings to change the shape and size of the
highlighting.
Use the "Show" list box to control when the highlight is visible. Note
that selecting "On hot key" means you control the highlight using the
Foci Highlights hot key and selecting "Dynamic tracking" means the
Cursor highlight stays visible until SuperNova is tracking a different
type of focus, for example, the mouse.
 Effects group.
You can choose from different colour options. Depending on the
option you choose you can also control the colour(s) and/or the
transparency.
Line tab.
 Highlight the Line check box.
Select this check box to turn on the highlighting of this focus. Deselect
this check box to turn off the highlighting of this focus.
 Display group.
Use the "Shape" settings to change the shape and size of the
highlighting.
Use the "Show" list box to control when the highlight is visible. Note
that selecting "On hot key" means you control the highlight using the
Foci Highlights hot key and selecting "Dynamic tracking" means the
Line highlight stays visible until SuperNova is tracking a different type
of focus, for example, the mouse.
 Effects group.
You can choose from different colour options. Depending on the
option you choose you can also control the colour(s) and/or the
transparency.
Focus tab.
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The term "Focus" refers to the focus used in dialog boxes and menus.
 Highlight the Focus check box.
Select this check box to turn on the highlighting of this focus. Deselect
this check box to turn off the highlighting of this focus.
 Display group.
Use the "Shape" settings to change the shape and size of the
highlighting.
Use the "Show" list box to control when the highlight is visible. Note
that selecting "On hot key" means you control the highlight using the
Foci Highlights hot key and selecting "Dynamic tracking" means the
Focus highlight stays visible until SuperNova is tracking a different
type of focus, for example, the mouse.
 Effects group.
You can choose from different colour options. Depending on the
option you choose you can also control the colour(s) and/or the
transparency.

13.11 Visual Mouse Pointers dialog box
Menu: Visual > Mouse Pointers

Available with SuperNova are mouse pointers that are larger and easier to
see than the usual Windows mouse pointers. The pointers are available in
a range of different colours and sizes.
Options:
 Scheme list.
You can choose an existing Mouse Pointer scheme from this list. If no
existing scheme is suitable, use the other options to create a new
scheme or modify an existing scheme.
 Type list and Pointer Image list.
The "Type" list shows the different pointers in Windows and the
"Pointer Image" list shows the different images you can apply to the
selected pointer type. To change a pointer, select the type of pointer
and then choose a pointer from the images provided.
 New button.
Pressing the "New" button will open the "Create New Scheme" dialog
box. In this dialog box, you enter a new name for the scheme. The
new scheme name appears in the "Scheme" list.
 Restore to defaults button.
If you have modified a default SuperNova scheme, then selecting this
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button will return the scheme back to the SuperNova default pointers
for the scheme.

 Delete button.
If you have created a new scheme, then pressing this button will open
a message window asking you to confirm that the scheme is to be
deleted. Choose "Yes" to delete the scheme or "No" to cancel.
 Custom pointer size group.
The options in this group allow you to adjust the size of the mouse
pointers in the current scheme, relative to their default size.
Use custom pointer size check box.
If you select this check box the value in the "Size" list will apply to all
pointers in the current scheme.
Size list.
The "Size" list contains a range of values you can apply to the
pointers in your current scheme. You can choose a fixed size, for
example 8, which will increase the pointers to 8 times their original
size. When a fixed value is chosen, the pointers will remain at the
same size regardless of what magnifier size you have set.
Alternatively, you can choose a value relative to your magnification
level, for example 150%. With a relative value, the pointer size will
adjust as you increase or decrease your magnification size. At higher
magnification levels you may find the fixed pointer size occupies too
much of the screen, so you may benefit from choosing a relative
pointer size smaller than the original size.
Use custom pointer in magnified areas only check box.
If you select this check box then the custom pointer size is only
visible in magnified areas. It is not visible when you turn off the
Magnifier or view the unmagnified screen in Views such as Split
Screen.

13.12 Visual Doc Reader Settings dialog box
Menu: Visual > Doc Reader Settings

The options available in the "Doc Reader Settings" dialog box control the
Doc Reader reading environment. You can open this dialog box by
selecting the item in the "Visual" menu or by selecting the "Settings" button
from the Doc Reader toolbar.
Options:
 Font settings.
In the Doc Reader you can define the font that is used to display the
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text within the document window.
use.

You can also state the font size to

 Colour settings.
You can define the colours to use in the document window. There are
three categories to which you can apply a foreground and background
colour too.
Document colours sets the background and foreground colours used
in the document window. However, if "Use document colours" is
selected then this setting will not be applied.
Word highlight colours sets the background and foreground colours
used by the Doc Reader for the current focus. This shows the
currently selected word as the Doc Reader reads through the
document. However, if "Invert word" is selected then this setting will
not be applied. Instead the highlight will be inverted based on the
custom colour settings.
Unit highlight colours sets the background and foreground colours
for your specified unit of movement. This is what is highlighted as
you cursor down through a document.
 Fetch whole document check box.
With the "Fetch whole document" check box selected you will load the
complete document into the Doc Reader. Depending on the size of
the document, this may take a few seconds. This option is only
supported in DOM enabled applications such as Microsoft Word,
Adobe Acrobat Reader, Internet Explorer, NotePad, WordPad, etc.
It is also possible to specify the number of lines you want to fetch by
unselecting the "Fetch whole document" check box and then
specifying the number of lines from the available spin control. This
will allow you to load a section of a document faster.
If you are working in an application that does not include DOM
support then the Doc Reader will load the content from the current
screen.
 Invert word check box.
With the selection of the "Invert word" check box the focus highlighting
will be an inverted highlight based on the document colours specified
or based on the actual document's colours depending on what is
currently enabled.
 Use document colours check box.
Selecting this check box will mean that the Doc Reader will use the
colours specified in the document instead of its own custom colours.
 Use document styles check box.
Selecting this option will mean styles used in the document will
appear in the Doc Reader.
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 Wrap line to. list.
The "Wrap line to" option can be used to insert a line break on a line if
it exceeds a particular length. This can be useful if lines are scrolling
outside the current window.
To disable this feature set the "Wrap line to" value to 0.
 Doc Reader speed slider.
The "Doc Reader speed" slider determines the reading speed for the
document.

13.13 Visual Multiple Monitors dialog box
Menu: Visual > Multiple Monitors

You choose the multiple monitor options in the Multiple Monitors dialog
box.
To use multiple monitors, SuperNova requires a graphics card attached to
the computer motherboard, such as an AGP/PCI or PCIe graphics card.
The use of USB graphic card adapters is not supported.
Options:
 Display Mode for Spare Monitors group.
The options in this group allow you to choose a multiple monitor setup
on computer's where you have chosen not to extend your desktop in
the Windows display options.
Single radio button.
You can use this option if you only wish to use a single monitor.
Span radio button.
You can choose this option if you wish to use two monitors to behave
as one large monitor. In this scenario, one single desktop will span
across both monitors and you can freely pan the magnification across
both monitors in the same way as you would with one monitor.
Clone radio button.
You can use this option to display the same output on all monitors
attached to the computer. All magnification and associated visual
settings will be the same on all monitors.
Clone with standard view radio button.
You can use this option to display the magnified output on the
primary monitor, with all other monitors displaying a standard
unmagnified screen. This can be useful in training situations where
another operator can view a screen without any visual effects to get
an overview of the entire display.
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Enable colour Scheme checkbox.
If you select this option when in Clone with Standard view, the
monitors displaying the unmagnified view will also show the Colour
Scheme in use.
Enable focus highlighting on extended desktop checkbox.
If you select this option when in Clone with Standard view, the
monitors displaying the unmagnified view will also show any Focus
Highlighting options in use.
 Display mode for extended desktop group.
You can use the options in this group to choose the most appropriate
setup for computers where the desktop has been extended onto
additional monitors. Note that you must select "Single" in the "Display
Mode for Spare Monitors" group to be able to extend the desktop in
the Windows Display Settings.
 Span radio button.
You can choose this option if you wish to use two monitors to behave
as one large monitor. In this scenario, one single desktop will span
across both monitors.
Side by side applications radio button.
You can use this mode to display different applications on different
monitors. When working with side by side applications the following
hot keys are of help:

Function
Jump mouse pointer to the
middle of the next monitor
Move application to right monitor

Move application to left monitor

Hot key
CAPS LOCK +
MIDDLE MOUSE
BUTTON
WINDOWS Logo Key
+ SHIFT + RIGHT
ARROW
WINDOWS Logo Key
+ SHIFT + LEFT
ARROW

Presentation Mode check box.
You use this option to have one monitor showing a magnified screen
and all the remaining monitors showing an unmagnified screen. For
example, this will allow you to work on a magnified screen while an
audience viewing a presentation slide show on the second monitor
will see an unmagnified screen.
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 Mouse Buffer check box.
You can use this option to prevent the accidental movement of the
mouse pointer onto another monitor when you are using an extended
desktop. You achieve this by creating a level of resistance at the
screen edge, which means you require additional force to move the
mouse pointer onto another monitor. You can adjust the level of
resistance the buffer creates by using the "Resistance" slider.
 Resistance slider.
You control the mouse buffer resistance using this slider. The higher
the level the greater the resistance, which means you have to hold the
mouse pointer against the edge of the screen for longer to move from
monitor to monitor.
 Switch monitor hot key list.
When working with "Side by side" applications on an extended
desktop, you may wish to move the mouse pointer quickly from one
monitor to the next, without panning the magnification away from the
area of the screen you are currently viewing. To do this, you can use
the "Switch Monitor" hot key. The default hotkey to switch between
monitors is CAPS LOCK + MIDDLE MOUSE BUTTON.
 Add Key, Replace Key and Remove Key buttons.
You can use these buttons to change the "Switch monitor" hot key.

13.14 Visual Advanced Options dialog box
Menu: Visual > Advanced Options

You can specify settings for a variety of SuperNova features by selecting
options in the "Visual Advanced Options" dialog box.
General Preferences tab
 Highlight Hot Key Action group.
Visual Highlights can be set to appear in a number of different ways.
One of these ways is to show the selected Highlights when a hot key
is pressed. How the hot key behaves when pressed is determined by
the "Show Highlight" list box. This can be set to "Until Hot Key
pressed again" or "Until Hot Key released".
 Fractional Magnification group.
The "Allow fractional magnification" check box determines whether
increases in the size of magnification will include fractional values. If
you turn fractional magnification off, nothing will immediately change.
Only after the next magnification adjustment will the factor move to
the nearest linear factor.
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If you experience issues when using fractional magnification sizes
then options are available to try and improve performance.
 Overview Mode group.
The settings in this group determine how the Magnifier position is
displayed on the screen when in Overview Mode. The magnified area
can be inverted or the background can be inverted. In this group
settings also determine the behaviour of the Overview Mode hot key.
This can be set to "Until Hot Key pressed again" or "Until Hot Key
released".
 Video Compatibility button.
This button will open the "Video Compatibility" dialog box. This dialog
box contains a number of check boxes for optimising the speed of the
magnification and resolving screen corruption problems caused by
non-compliant video drivers.
Magnifier tab.
 Lock Aspect check box.
If the "Lock Aspect" check box is unselected then you will have two
spin controls that will allow you to adjust the horizontal and vertical
magnification size independently. If you turn lock aspect ratio back on,
the magnification factor will change to the average of the horizontal
and vertical factors. Note that True Fonts is unsupported when
working with a different horizontal and vertical magnification size.
 Screen Edge Behaviour group.
The settings in this group are specific to the Magnifying Glass and
Auto Resizing Glass view options. The radio buttons in this group
determine the behaviour of the magnified window as it moves towards
the edge of the screen. The default setting is "Normal".
The "Normal" setting positions the magnified window on the screen
directly in proportion to the position of the mouse pointer. The
"Relative to screen edge" option will move the magnified window
when the pointer or cursor hits the appropriate scroll margin. The
magnified window will stop moving when it hits the sides of the screen.
The "Move past screen edge" option simulates what you would see if
you held a "real" magnifying glass over the pointer. The magnified
window may move off the side of the screen taking the mouse pointer
with it. This mode works best if you have 100% scroll margins.
 Font Smoothing group.
Font smoothing improves the legibility of the text on the screen when
you use magnification. Options include:
None radio button.
Choose "None" to turn off Font Smoothing.
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Standard radio button.
Choose "Standard" for basic font smoothing. Use this option if you
are experiencing performance issues using True Fonts.
True Fonts radio button.
Choose "True Fonts" for perfect clarity at all magnification sizes. You
may wish to experiment with the True Font Settings if you are using a
magnification size of 3x or lower or you are using an LCD monitor.
 True Fonts Settings group.
Standard radio button.
Using "Standard" renders text in a non- antialiased mode. This is the
default and fastest method, especially when using a magnification
size of 4x or greater.
Antialiased radio button.
This setting renders the text and smooth's the text edges. If you
experience jagged effects using True Fonts at a low magnification
size then you should select this option.
You can switch between "None", "Standard" and "True Fonts" by using a
SuperNova hot key.
Magnifier Hot Keys
Function

Font Smoothing

Desktop Default
NumPad Set
LEFT
CONTROL +
NUMPAD 8

Laptop Universal Set
No
Assignment

Note that True Fonts is unavailable if you are using a different vertical and
horizontal magnification ratio. You can independently change the vertical
and horizontal magnification size by deselecting the "Lock Aspect" check
box in the "Visual Advanced Options" dialog box.
Tracking tab.
 Mouse tracking group.
In this group the "Track mouse" check box controls whether
Supernova follows the mouse pointer. When tracking the mouse
pointer the window will scroll whenever the mouse is moved beyond
the mouse frame. The distance that it moves will normally be just
enough so that the mouse ends up at the edge of the screen or
margin. To adjust the mouse frame, press the mouse frame button.
This takes you to the Mouse and Foci Frame Dialog Box.
The "Mouse to screen" check box determines what happens when the
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mouse pointer is currently not visible inside the magnified window.
With this option selected, when the mouse pointer is initially moved,
the mouse pointer will be brought to the centre of the magnified
window. If this option is unselected then the magnified window will be
moved to the mouse pointer's location on the screen.
If the "Stay in window" check box is selected, artificial mouse
boundaries are created around the currently selected window. This
places a restriction on the mouse pointer so the display does not
easily move away from the current window. These mouse boundaries
are removed if you move the pointer beyond the edge of the window.
 Cursor tracking group.
The "Cursor tracking" check box controls whether the Magnifier
follows the beam cursor inside edit areas. If this checkbox is selected,
the magnified window will move to show the area around the cursor
as it moves. The Cursor Frame (the minimum distance between the
beam and the edge of the screen) can be set in the Caret Frame
dialog box by pressing the "Cursor Frame" button.
The Mouse and Foci Frame section contains information about a
Frame and how to set one up.
 Focus tracking group.
In this group you can state whether the Magnifier tracks other types of
objects. Available options are menus, controls and windows.
The "Centring" check box sets whether any windows that are being
tracked such as menus and small dialog boxes are to be centred in
the magnified window if they fit. If "Centring" is not selected the
display will move the minimum amount possible to make the object
completely visible.
Line View tab.
Line View is a SuperNova reading mode. In this mode the content of the
visible screen is shown as a single line scrolling across the screen. Line
View lets you control background and text colour, text size and what font to
use.
Hooked Areas tab.
Hooked Areas allow you to keep a particular area of the screen
permanently displayed. This lets you keep an eye on important information
that may frequently change as you use your application.
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13.15 General Startup Preferences dialog box
Menu: General > Startup Preferences

You can specify settings for a variety of SuperNova features by selecting
options in the "Startup Preferences" dialog box. The availability of some
options depends on the synthesiser you are using and whether you are
running a local, network or Dolphin Pen version of SuperNova.
Options
 Launch SuperNova after logon check box.
You can set your computer to automatically run SuperNova after you
log into your user account by selecting this check box.
 Disable splash screen at startup check box.
You can stop the SuperNova splash screen showing by selecting this
check box. A splash screen is an image that appears while a
computer program is loading.
 Magnifier at user logon check box.
You can magnify the Windows Logon Screen by selecting this check
box. After selecting this check box, the next time you restart your
computer you will have a SuperNova toolbar showing on the Windows
Logon Screen. You can use the mouse to click the toolbar buttons to
adjust magnification or press F7 to reduce magnification and F8 to
increase magnification.
Note: Magnification at the Windows Logon Screen is only possible by
having a SuperNova component running as a Windows service. You
cannot run a full program at the Windows logon screen because of
Windows security restrictions.
 Show magnification buttons at logon check box.
You can hide the SuperNova toolbar that appears at the Windows
Logon Screen by deselecting this item.
 Always save user settings check box.
By default, SuperNova will automatically save changes you make to
SuperNova settings. You can prevent this behaviour by deselecting
the "Always save user settings" check box. When this check box is
unselected then you must manually save the changes you make. You
can do this by selecting the "Save Settings" option in the "File" menu.
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 Ask user check box.
The "Ask user" check box becomes available when you deselect the
"Always save user settings" check box. If you select the "Ask user"
check box, then SuperNova will ask you if you want to save the
changes you have made when you quit SuperNova.

13.16 General Update Settings dialog box
Menu: General > Update Settings

The "Update Settings" dialog box sets when SuperNova automatically
checks for updates. SuperNova can check daily, weekly, monthly or never.
You can also keep SuperNova up-to-date by selecting "Check for Updates"
from the "Help" menu.

13.17 General Control Panel dialog box
Menu: General > Control Panel

The "Control Panel" dialog box contains global settings to control the
SuperNova user interface.
 Access System Language list.
This list box lets you change the SuperNova system language. This
includes all of the text in the SuperNova control panel, synthesiser
output language and help files.
 Enable helpful warnings check box
This checkbox switches the helpful warnings on or off. An example for
a helpful warning is the graphics training: If you press the hot key for
graphic training but graphic training is switched off you can get a
warning.
 Enable help messages check box.
Help messages can appear to guide you through specific tasks. If
this option is unselected then these messages will not appear. It is
also possible to disable specific help messages when they appear by
unselecting the "Do not show this message again" check box within
the message window itself.
 Use Default Settings in the control panel check box.
By default, you will use the current SuperNova settings when going
through the SuperNova control panel. This lets you experience the
effects of change to settings as they happen.
In some cases, settings you wish to use in your application may not
be suitable for the SuperNova control panel. Selecting this check box
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means SuperNova will switch to use the Default Application settings
and not your custom Application Settings.

 Hide when minimised check box.
You can prevent the SuperNova control panel being on the Taskbar
and part of the "Switch To" dialog box by selecting this check box.
You can continue to access the SuperNova control panel with the
"Open control panel" hot key or through the System Tray.
 Menu bar and Button Bar Style radio buttons.
You can show the SuperNova control panel only as a menu bar or as
a menu bar and button bar. The Button Bar Style includes large
graphical buttons which offer easy access to the main SuperNova
settings.
 Status bar check box.
You can hide the status bar that is part of the SuperNova control
panel by deselecting this check box.
The status bar contains information about the application and the
current settings file in use. All changes you make in the control panel
apply to this settings file.
 Always on top check box.
If this setting is enabled then the SuperNova control panel will always
be on top of other windows.
 Start with panel ... radio buttons.
You can control the appearance of the SuperNova control panel when
SuperNova starts. You can set the control panel to be showing,
minimised or at the same position when you last closed SuperNova.

13.18 General Keyboard dialog box
Menu: General > Keyboard and Hot Keys > Keyboard

You can specify what keyboard layout and hot key set you want to use in
the "Keyboard" dialog box.
Options:
 Keyboard list.
The "Keyboard" list box sets the keyboard type. This does not have to
be a true reflection of the keyboard you are using.
 Language list.
The "Language" list box should match your Windows keyboard layout.
The value relates to Keyboard Announcements and hot key
assignments.
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 Set list.
The "Set" list box specifies the hot key set to be used. The sets
available will be restricted by the selections in the "Keyboard" list and
"Language" list.
 Restore default hot keys button.
You can restore any changes you may have made to a hot key set by
selecting this button.
 Num Lock On enables Number Pad keys check box.
You can enter numbers using your keyboard's Number Pad by
selecting this check box. If you do select this option then turn the Num
Lock Off to use SuperNova hot keys that use the Number Pad.

13.19 General Hot Keys dialog box
Menu: General > Keyboard and Hot Keys > Hot Keys

You can add, replace or remove any hot key assignments to SuperNova
commands by using options in the "Hot Keys" dialog box. Note that the list
of commands are global commands. Hot keys defined in Scripts and Maps
cannot be changed using this dialog box.
To learn more about modifying hot keys, see the "Resolve Hot Key
Conflicts" topics in this user guide.

13.20 General Touchscreen Settings dialog box
Menu: General > Touchscreen Settings

The "Touchscreen Settings" dialog box contains options that you can use
to adjust the SuperNova touchscreen experience.
General tab.
 Double tap timeout slider.
This setting controls the duration between first and second taps for
the gesture to be considered a double tap action. You can increase
the time allowed between the first and second taps by moving the
slider to the right.
 Jitter Margin slider.
The Jitter Margin is The distance an initial touch can wander before
SuperNova thinks you are performing a swipe gesture. You can
increase the allowable distance by moving the slider to the right.
Magnification tab.
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 Display Touch Bar check box.
The SuperNova Touch Bar is a touchscreen toolbar that appears at
the bottom of the screen when you do a 3 finger single tap. As well
as using the gesture, you can also control the appearance of the
Touch Bar by adjusting the status of this check box.
 Flick Inertia slider.
Performing a single finger swipe moves the magnified screen with
inertia. The faster you perform the swipe the further the SuperNova
magnified screen travels. This slider controls the level of resistence
SuperNova applies to the motion. You can reduce the level of
resistence by moving the slider to the right.
 Auto-Scroll Zone Width slider.
The "Auto-Scroll Zone Width" is the distance your finger needs to be
from the edge of the screen before SuperNova starts automatically
scrolling the rest of the screen into view. You can increase the size of
the margin by moving the slider to the right.
 Auto-Scroll Zone Speed slider.
The "Auto-Scroll Zone Speed" sets how fast SuperNova starts
automatically scrolling when your finger enters the auto-scroll zone.
You can increase the auto-scrolling speed by moving the slider to the
right.
 Pass-Through Timeout slider.
The "Pass-Through Timeout" is the duration before which a press
turns into a pass-through gesture.
 Automatically Scroll applications check box.
This setting controls whether a swipe gesture automatically scrolls the
content within an application window when the magnified window is at
the edge of the screen. For example, if you are reading a web page
and the magnified window is at the bottom of the screen, performing a
swipe will automatically scroll the web page, bringing more content
into view. Applications that support this feature include the Start
Screen, Internet Explorer, Adobe Reader and Microsoft Word.
On Screen Keyboard tab.
 Automatically Open in Desktop Apps check box.
SuperNova automatically shows the onscreen keyboard when you
need to type and you do not have a keyboard connected to the device.
You can turn off the automatic appearance of the onscreen keyboard
when you are using desktop applications by deselecting this setting.
With this setting turned off, you can still make the keyboard appear at
any time by tapping the Keyboard button in the SuperNova Touch Bar
or by tapping the Keyboard button in the Windows Notification area.
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 Colour Scheme list.
You can change the appearance of the SuperNova onscreen
keyboard by choosing an alternative colour scheme from this list. The
colour schemes available offer large print high contrast colour
combinations to make it easy to view the keyboard.

13.21 General Advanced Options dialog box
Menu: General > Advanced Options

You can specify settings for a variety of SuperNova features by selecting
options in the "General Advanced Options" dialog box.
System Configuration tab
 Windows Settings button.
SuperNova makes some changes to your system to ensure best
accessibility. You can disable any of the changes made by selecting
this button to open the "Windows Settings" dialog box and deselecting
any listed item.
Detection Settings tab
 Allow remote mapping check box.
You can enable remote mapping by selecting this check box. This
allows computers running the Dolphin remote training utility to connect
to your computer.
For security reasons, if you enable this option it will be automatically
turned off when you quit SuperNova.
 Read in columns if present check box.
You can organise the screen into columns based on SuperNova's
internal detection system by selecting this check box. This influences
the reading options in SuperNova in areas with no Document Object
Model (DOM).

13.22 Item Finder dialog box
Menu: General > Item Finder

You can use the Item Finder to list certain objects in an application window.
You can then select the objects and perform actions upon them. Examples
include clicking a link on a web page or moving to a heading in a
document.
You can use the item finder in programs like Microsoft Office and Windows
Internet Explorer.
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If you are in an application that does not support the Item Finder then the
Item Finder is disabled.
To learn more about the Item Finder and the support it offers for your
application see the SuperNova Help available for your application.
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